Sentinel Cloud V.3.6
Sentinel Cloud EMS User's Guide
Software Version

This documentation is applicable for the Sentinel Cloud version 3.6.

Document Revision History

Part Number 007-012136-001, Revision G

May 2015

<table>
<thead>
<tr>
<th>Revision</th>
<th>Action/Change</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Sentinel Cloud 3.0 Release</td>
<td>December 2012</td>
</tr>
<tr>
<td>B</td>
<td>Sentinel Cloud 3.1 Release</td>
<td>April 2013</td>
</tr>
<tr>
<td>C</td>
<td>Sentinel Cloud 3.2 Release</td>
<td>July 2013</td>
</tr>
<tr>
<td>D</td>
<td>Sentinel Cloud 3.3 Release</td>
<td>September 2013</td>
</tr>
<tr>
<td>E</td>
<td>Sentinel Cloud 3.4 Release</td>
<td>December 2013</td>
</tr>
<tr>
<td>F</td>
<td>Sentinel Cloud 3.5 Release</td>
<td>July 2014</td>
</tr>
<tr>
<td>G</td>
<td>Sentinel Cloud 3.6 Release</td>
<td>May 2015</td>
</tr>
</tbody>
</table>

Disclaimer and Copyrights

Copyright © 2015, SafeNet, Inc. All rights reserved.

http://www.safenet-inc.com/

We have attempted to make this document complete, accurate, and useful, but we cannot guarantee it to be perfect. When we discover errors or omissions, or they are brought to our attention, we endeavor to correct them in succeeding releases of the product. SafeNet, Inc., is not responsible for any direct or indirect damages or loss of business resulting from inaccuracies or omissions contained herein. The specifications contained in this document are subject to change without notice.

SafeNet®, Sentinel®, and EMS™ are registered and/or unregistered trademarks of SafeNet, Inc., in the United States and other countries. All other trademarks referenced herein are registered and/or unregistered trademarks of their respective owners.
# Table of Contents

Table of Contents ........................................................................................................ iii

Preface ......................................................................................................................... ix

Chapter 1: Introduction ............................................................................................. 1

1.1. Features and Benefits ...................................................................................... 1
    1.1.1. Centralized License Management Interface .............................................. 1
    1.1.2. Simplification of Licensing and Fulfillment Functions ......................... 1
    1.1.3. Data Collection & Reporting ................................................................. 2
    1.1.4. Sentinel Professional Services and Technical Support ................... 2
    1.1.5. Internationalization Support .............................................................. 2

1.2. Sentinel Cloud EMS System Components ..................................................... 3

Chapter 2: Getting Started ....................................................................................... 5

2.1. Logging on to EMS ......................................................................................... 5
    2.1.1. Forgot Password? .............................................................................. 5
    2.1.2. Changing Password ......................................................................... 5

2.2. Home Page ...................................................................................................... 6
    2.2.1. Entitlements Chart ........................................................................... 6
    2.2.2. Top 5 Customers Chart .................................................................... 7
    2.2.3. Top 5 Count Based Features Used ................................................... 7
    2.2.4. Top 5 High Selling Products in Last 30 Days ................................. 7

2.3. Role-based Access ......................................................................................... 7

2.4. EMS Workflow .............................................................................................. 9

Chapter 3: User Authorization ................................................................................. 11

3.1. Creating a Role .............................................................................................. 12

3.2. Associating Read/Write Permissions with a Role ......................................... 13

3.3. Creating a User ............................................................................................. 14

3.4. Associating Roles with a User .................................................................... 15

3.5. Managing Roles ........................................................................................... 16
    3.5.1. Viewing All Roles ........................................................................... 16
    3.5.2. Searching a Role(s) ....................................................................... 16
    3.5.3. Viewing the Details of a Role ........................................................... 16
    3.5.4. Editing a Role ................................................................................. 16
    3.5.5. Deleting a Role ............................................................................... 17
3.6. Managing Users ........................................................................................................17
  3.6.1. Viewing All Users ........................................................................................... 17
  3.6.2. Searching Users ............................................................................................. 17
  3.6.3. Viewing the Details of a User ......................................................................... 17
  3.6.4. Editing User Details ....................................................................................... 17
  3.6.5. Deleting a User ............................................................................................... 18
  3.6.6. About SFNTSupport User ................................................................................ 18

Chapter 4: Namespaces ..................................................................................................... 21
  4.1. What is a Namespace? .......................................................................................... 22
  4.2. Creating a Namespace ......................................................................................... 22
  4.3. Associating Namespace Permission with a Role ................................................. 23
  4.4. Managing Namespaces ...................................................................................... 23
      4.4.1. Searching Namespaces .............................................................................. 24
      4.4.2. Viewing the Details of a Namespace ......................................................... 24
      4.4.3. Editing Namespace Details ........................................................................ 24
      4.4.4. Deleting a Namespace ................................................................................ 24

Chapter 5: Product Management Tasks ............................................................................. 25
  5.1. What is a License Model? .................................................................................... 26
      5.1.1. License Attributes .................................................................................... 27
      5.1.2. Basic License Models ................................................................................ 31
      5.1.3. Viewing All License Models ...................................................................... 34
      5.1.4. Creating a License Model by Copying an Existing One .............................. 35
      5.1.5. Examples On Creating Licenses .................................................................. 36
  5.2. What is a Service Agreement? .............................................................................. 38
      5.2.1. Viewing All Service Agreements ............................................................... 39
      5.2.2. Creating a Service Agreement by Copying an Existing One ..................... 39
  5.3. What is a Feature? ............................................................................................... 41
      5.3.1. Feature Level Authorization ...................................................................... 41
  5.4. What is a Product? ............................................................................................... 42
  5.5. Lifecycle of a Product ........................................................................................ 43
      5.5.1. Marking a Product as Complete .............................................................. 44
      5.5.2. Marking a Product as End of Life (EOL) ................................................ 44
  5.6. Creating a Feature ............................................................................................... 44
  5.7. Associating License Model with a Feature ......................................................... 46
  5.8. Creating a Product ............................................................................................. 47
  5.9. Associating Features with a Product ..................................................................... 48
  5.10. Associating a Service Agreement with a Product ............................................ 49
  5.11. Managing Features ........................................................................................... 50
      5.11.1. Viewing All Features ................................................................................. 50
5.11.2. Searching a Feature(s) ................................................................. 50
5.11.3. Viewing the Details of a Feature .................................................. 50
5.11.4. Editing the Feature Details ......................................................... 51
5.11.5. Deleting Feature(s) ................................................................. 51
5.12. Managing Products ...................................................................... 52
  5.12.1. Viewing All Products .............................................................. 52
  5.12.2. Searching a Product(s) ........................................................... 52
  5.12.3. Viewing the Details of a Product .............................................. 52
  5.12.4. Editing Product Details ........................................................... 52
  5.12.5. Deleting a Product ................................................................. 53

Chapter 6: Customers and Contacts .................................................. 55
  6.1. What is a Customer? .................................................................... 56
    6.1.1. About Customer Reference ID ................................................ 56
  6.2. What is a Contact? ...................................................................... 56
  6.3. Creating a Customer .................................................................. 57
  6.4. Managing Customers .................................................................. 59
    6.4.1. Viewing All Customers .......................................................... 59
    6.4.2. Searching Customers .............................................................. 59
    6.4.3. Viewing the Details of a Customer ........................................ 59
    6.4.4. Editing Customer Details ....................................................... 59
    6.4.5. Deleting a Customer ............................................................. 60
  6.5. Creating a Contact ..................................................................... 60
  6.6. Managing Contacts .................................................................... 63
    6.6.1. Viewing All Contacts ............................................................ 63
    6.6.2. Searching Contacts ............................................................... 63
    6.6.3. Viewing the Details of a Contact .......................................... 63
    6.6.4. Editing Contact Details ......................................................... 63
    6.6.5. Deleting a Contact ............................................................... 64

Chapter 7: Managing Entitlements ...................................................... 65
  7.1. What is an Entitlement? .............................................................. 66
  7.2. Deployment Types ...................................................................... 66
  7.3. Entitlement Types ..................................................................... 67
    7.3.1. Which Entitlement Types are Supported by Various Deployment Types? .............................................. 67
  7.4. Lifecycle of an Entitlement .......................................................... 67
  7.5. Creating an Entitlement ............................................................... 69
    7.5.1. Understanding Relation between Deployment Type and Entitlement Type ............................................ 69
    7.5.2. Entitlement Generation Workflows ....................................... 70
    7.5.3. Entering Basic Entitlement Details ....................................... 75
    7.5.4. Adding Products to an Entitlement ................................. 78
    7.5.5. Configuring License Model Attributes for the Features 83
# Table of Contents

10.6. Enabling Notifications ........................................................................................................ 119
10.7. Downloading Notification E-mail Templates for Customization ........................................ 120

### Chapter 11: Admin Console ........................................................................................................ 123
11.1. Outgoing E-mail Server Settings .......................................................................................... 123
11.2. Entitlement Certificate E-mail Settings ................................................................................ 124
11.3. General Settings .................................................................................................................. 125
11.4. On-premise Licensing Settings ............................................................................................ 125
11.5. License Model Time to Live (TTL) ....................................................................................... 128
11.6. Concurrency Cleanup and Abandoned Session Handling .................................................... 128
11.7. Technical Support Contacts ................................................................................................ 130
11.8. Action Buttons ..................................................................................................................... 130

### Chapter 12: The Customer Portal ............................................................................................... 131
12.1. Logging-in to the Customer Portal ....................................................................................... 131
12.2. Viewing Entitlement Details ............................................................................................... 132
12.3. Managing User IDs .............................................................................................................. 132
   12.3.1. Adding User IDs to Enterprise Named Entitlements ....................................................... 133
   12.3.2. Deleting User IDs from the Enterprise Named Entitlements ......................................... 133
12.4. Viewing Usage Data ............................................................................................................ 133
12.5. Viewing Billing Data .......................................................................................................... 134
12.6. Retrieving License State ..................................................................................................... 134
12.7. Viewing Concurrent Session .............................................................................................. 134
12.8. Viewing Usage Count ........................................................................................................ 135
12.9. Managing Secondary Contacts .......................................................................................... 135
   12.9.1. Creating a New Secondary Contact ............................................................................ 135
   12.9.2. Editing Secondary Contacts ....................................................................................... 136
   12.9.3. Deleting Secondary Contacts .................................................................................... 136
   12.9.4. Associating Secondary Contacts to an Entitlement ..................................................... 136
   12.9.5. Removing Secondary Contacts from an Entitlement .................................................. 136

**Appendix A: Capacity** .................................................................................................................. 137

**Glossary** .................................................................................................................................... 141
What Does This Document Contain?

This guide contains information about using the Sentinel Cloud EMS portal through a Web browser.

Conventions Used in This Document

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold lettering</td>
<td>Denotes keystrokes, menu items, window names, and fields.</td>
</tr>
<tr>
<td>Courier</td>
<td>Denotes syntax, prompts, and code examples.</td>
</tr>
<tr>
<td>Italic lettering</td>
<td>Denotes file names and directory names. Else, used for emphasis.</td>
</tr>
</tbody>
</table>

Documentation Resources

Visit documentation.sentinelcloud.com to access the product documentation.

Obtaining Support

If you encounter a problem while installing, registering or operating this product, please make sure that you have read the documentation. If you cannot resolve the issue, contact your supplier or SafeNet Customer Support. SafeNet Customer Support operates 24 hours a day, 7 days a week. Your level of access to this service is governed by the support plan arrangements made between SafeNet and your organization. Please consult this support plan for further information about your entitlements, including the hours when telephone support is available to you.

<table>
<thead>
<tr>
<th>Contact Method</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>SafeNet, Inc.</td>
</tr>
<tr>
<td></td>
<td>4690 Millennium Drive</td>
</tr>
<tr>
<td></td>
<td>Belcamp, Maryland 21017, USA</td>
</tr>
<tr>
<td>Phone</td>
<td>US</td>
</tr>
<tr>
<td></td>
<td>1-800-545-6608</td>
</tr>
<tr>
<td></td>
<td>International</td>
</tr>
<tr>
<td></td>
<td>1-410-931-7520</td>
</tr>
<tr>
<td>Technical Support</td>
<td><a href="https://serviceportal.safenet-inc.com">https://serviceportal.safenet-inc.com</a></td>
</tr>
<tr>
<td>Customer Portal</td>
<td>Existing customers with a Technical Support Customer Portal account can log in to manage incidents, get the latest software upgrades, and access the SafeNet Knowledge Base</td>
</tr>
</tbody>
</table>

Documentation Feedback

To help us improve future versions of the documentation, we want to know about any corrections, clarifications, or further information you would find useful. When you contact us, please include the
following information:

- The title, part number (if applicable), and version of the document you are referring to
- The version of the product you are using
- Your name, company name, job title, phone number, and e-mail ID

Send us e-mail at: support@safenet-inc.com
1 Introduction

Welcome to Sentinel® EMS™—a Web-based solution that provides you with a centralized interface for all your license and entitlement management functions. It offers an easy-to-use interface for all your back office systems and a variety of advanced data collection and reporting functions. It also provides a centralized license management interface for employees, customers, and partners.

Sentinel Cloud EMS can help you in reaching new markets, improving the satisfaction of existing customers, and maximizing profitability by minimizing the internal costs and resources required for licensing, improving operation processes, empowering channel partners, and improving the end-user experience.

1.1 Features and Benefits

1.1.1 Centralized License Management Interface
Sentinel Cloud EMS enables you to improve license lifecycle management capabilities, reduce support costs, and enhance the end-user experience by offering a centralized license management interface for employees, partners, and end-users.

- **Role-Based Vendor Portal** – Easily create, implement, and manage users, roles, and privileges that will enable customer service, sales, marketing, fulfillment, and product management employees to use a single system to improve customer relations and product life cycle management.

- **End-User Self-service Portal** – Reduce support costs and enhance the user experience by enabling the end-users to automatically deploy, renew, upgrade, and revoke products without needing to contact your customer support team.

1.1.2 Simplification of Licensing and Fulfillment Functions
Sentinel Cloud EMS enables you to simplify manual, time-consuming operational, compliance, and reporting functions throughout the entire license lifecycle. Automation of licensing fulfillment, deployment, and management processes enables you to maximize profitability and improve business operations.

- **License Fulfillment & Delivery Automation** – Minimize time-consuming manual data entry and tracking functions to eliminate errors, save time, and reduce fulfillment costs by automating licensing and entitlement functions.
■ **Quick & Easy Product Configuration** – Reduce development and inventory costs while shortening time to market by enabling fulfillment teams, and customers to quickly and easily build and deploy new product packages and license models without involving IT or engineering.

■ **Quick Entitlement Creation & Management Functions** – Reduces the cost of software production cycles and simplifies the deployment process.

### 1.1.3. Data Collection & Reporting

Sentinel Cloud EMS enables more effective product marketing, sales, and management by providing data collection and reporting features that allow you to more accurately forecast your renewal, upgrade, and budgeting figures, as well as determine how products are being deployed and used.

■ **Simple End User Compliance Reporting** – Improve the customer experience with straightforward entitlement tracking and reporting tools that enable end-users to easily ensure they are not inadvertently exceeding paid license usage.

■ **Customizable License Tracking & Reporting** – Increase the value of every customer and reduce operating costs by improving support, marketing, and sales effort throughout the product lifecycle with flexible usage tracking and reporting tools.

■ **Business Intelligence** – Leverage the system to identify, test, and implement new and more effective packaging, pricing, and distribution models to reach new markets and maximize revenue.

### 1.1.4. Sentinel Professional Services and Technical Support

The SafeNet Professional Services team is available to help you plan for and implement Sentinel Cloud EMS, allowing you to fully realize its benefits in an optimal time frame. The SafeNet Technical Services organization provides worldwide telephone, e-mail, and Internet-based support to our customers. Our SafeNet Service Guarantee ensures that you consistently receive the highest level of product.

### 1.1.5. Internationalization Support

Sentinel Cloud EMS provides support for Unicode character encoding to implement internationalization. With the internationalization support, the data can be stored and transmitted in languages other than English, such as Japanese.
1.2. Sentinel Cloud EMS System Components

The following diagram identifies the various components of Sentinel Entitlement Management System.

The components of Sentinel Cloud EMS are explained as follows:

**Server Side Components**

EMS uses the following server side components:

- **Apache Tomcat Web Server**: The application server hosting EMS Web Application. The EMS Web Application is installed on this server.

- **EMS Web Application**: A Web application that provides an easy-to-use Web interface for defining product catalogs, managing customers, users, and entitlements.

- **EMS Database Server**: Sentinel Cloud EMS supports MYSQL Server as the database server. The database can reside on a separate server or on the application server. The address of the database server, database name, user ID, and password can be specified while installing EMS on the Web Server.

- **Enforcement Technology**: EMS provided with Sentinel Cloud Services uses Sentinel Cloud as the enforcement technology.

**Client Side Components**

EMS supports the following types of requests from the client side:
- **HTML Over HTTP(S)**: Users can access the EMS portal over a network using the URL of the Apache Tomcat server. They can log on to EMS using their User ID and password and perform various tasks in EMS according to the role assigned to them by the administrator.

- **ERP, CRM**: Organizations can integrate the Features of EMS to their existing Entitlement management applications (like ERP, CRM, ESB) by using the Web services provided by EMS.
2.1. Logging on to EMS

To access the EMS portal, use the URL http://<Hostname>:8080/ems/login.html, where <Hostname> stands for the host name/IP address/domain name of the EMS server. The login page appears.

When logging on for the first time, type the User ID and Password assigned by the system administrator and click Login. You can change your password once you are logged on.

2.1.1. Forgot Password?

1. On the login page, click Forgot Password.
2. Enter your Email ID as specified in your EMS user profile and click Recover Password. Your password will be e-mailed to you.

If you do not remember the e-mail address you had provided at the time of account creation, contact the EMS administrator for help in recovering your password.

2.1.2. Changing Password

You can change the password that you used to log on to Sentinel Cloud EMS.

If you are authorized to perform administrative functions, you can change the password for other users. For more information, see Editing User Details.

To change your own password:

1. Login to EMS with your User ID and Password.
2. At the top-right corner of the page click Change Password.
3. Type your current password in the Old Password field.
4. Type your new password in the New Password and Confirm Password fields.

Password is case sensitive and its length should be between 6 to 30 characters.

5. The E-mail field appears only for the admin login. The administrator needs to change the dummy e-mail ID at the first login.
6. Click Save.
2.2. Home Page

The home page provides dashboard-like view of the important Entitlement-related items. This page appears for the users who have 'View' permission (or higher) on the Entitlements module.

2.2.1. Entitlements Chart

Presents a graphical representation of entitlements generated by all the users of the system by Monthly, Weekly, and Daily view.

**Monthly view**

Presents the entitlements for last 6-7 months. All the entitlements created in a month represent the corresponding node on the graph. Put the mouse pointer over any node to view the number of entitlements in that month.

**Weekly view**

Presents the entitlements for last 5-6 weeks. All the entitlements created in a week represent the corresponding node on the graph. Put the mouse pointer over any node to view the number of entitlements in that week.

**Daily view**

Presents the entitlements for last 7-8 days. All the entitlements created in the a day represent the corresponding node on the graph. Put the mouse pointer over any node to view the number of entitlements in that day.

This graph considers only enabled and disabled entitlements.
2.2.2. Top 5 Customers Chart

Presents a pie chart for five customers with the highest number of entitlements in the last year, month, or week. All the customers are represented with different colors and the corresponding number of entitlements are listed in the lower part of the pane.

When an entitlement is reconfigured, the total number of entitlements (listed in lower part) increases by one.

**Last Year**

 Presents the top five customers during the past 365 days.

**Last Month**

 Presents the top five customers during the past 30 days.

**Last Week**

 Presents the top five customers during the past 7 days.

2.2.3. Top 5 Count Based Features Used

The table displays the top five features used for all the count-based license models.

2.2.4. Top 5 High Selling Products in Last 30 Days

The table presents a list of products for which the highest number of entitlements were generated in the last 30 days. Only top five products are shown in the table.

2.3. Role-based Access

Sentinel Cloud EMS is role-based, and the tasks you can perform depend on the user roles assigned to you. EMS provides a pre-defined administrative user called **admin**. The admin can define custom roles and associate permissions with the roles. He can also associate these roles with users.

The main roles to be considered when using Sentinel Cloud EMS are:

- **Administrator** role
- **Product Manager** role
- **Contract Operator** role
- **Customer’s Administrator** role

Typically to use EMS, you will assume a role similar to the above. However, the role names may vary in your organization.
The responsibilities of user roles are explained below.

**Administrator**

The person responsible for defining and managing namespaces, users, and roles.

**Functions**

- Namespace management
  - Create, modify, and remove namespaces
- Role management
  - Create, modify, and remove roles
  - Set global permissions for a specific role
  - Set catalog permissions for a role
- User management
  - Create, modify, and remove users
  - Edit user details
  - Assign a specific role to a user
- Custom Attributes management
- Admin Console Management

**Product Manager**

The person who determines the product components to be protected (called features), and how these components are used to define Products.

**Functions**

- Use license models
  - View license models
  - Copy license models
- Use service agreements
  - View service agreements
  - Copy service agreements
- Catalog management
  - Create, modify, and remove features, and products
  - Associate license models to feature
  - Associate feature to product
  - Associate service agreement to product
**Contract Operator**

The person who performs order management or production functions. These include defining, managing, and provisioning customer orders.

**Functions**

- Create, modify, and remove customers and contacts
- Entitlement management
  - Create and manage entitlements (for customers/end users)
  - Manage User IDs
- Report generation

**Customer’s Administrator**

**Functions**

- View Entitlements
- Manage User IDs, in case of named enterprise entitlements
- View/Export Usage Information
- View current state of features and licenses
- Manage other customer contacts, if the contact type is primary

## 2.4. EMS Workflow

Following is a typical workflow depicting the major tasks in EMS, their sequence, and the role responsible to perform each task. For information on role types in EMS, refer to the topic "Role-based Access".

![Typical EMS Workflow Diagram]
User Authorization

The typical user considered in this chapter is an Administrator or a user having administrative permissions in EMS who is responsible for managing access rights.

Every user must have a user name and password in order to log in to the EMS portal. Therefore, before using EMS you need to create users and link them to roles. The roles define permissions and access to use various functionalities of EMS. Permissions are not assigned to users directly, but are grouped into roles, and users can be assigned one or more roles.

EMS can be used by various departments in your organization such as product management, sales, order generation, fulfillment, and customer support. You can create access levels and permissions for groups within your organization by defining users and roles within EMS. The first step you need to take is to log in to EMS as a system administrator. This is the default user shipped with EMS. Roles grant different levels of access to EMS.

The following topics are addressed in this chapter:

3.1. Creating a Role ................................................................. 12
3.2. Associating Read/Write Permissions with a Role .......................... 13
3.3. Creating a User ................................................................. 14
3.4. Associating Roles with a User ............................................. 15
3.5. Managing Roles ............................................................... 16
3.6. Managing Users ............................................................... 17
3.1. Creating a Role

To create a new role, follow the steps below.

1. On the main menu, click Users > Roles. The Roles page appears.

2. Click New on the right side of the page. The Add Role pop-up appears.

3. Enter a name for the role in the Role Name field. (The name can be alphanumeric and maximum length is 50 characters.)

4. Leave the Status check box selected for the role to be enabled. If you want to keep the role disabled so that you can enable it when needed, clear this check box.

5. Provide a description for the role in the Description field.
6. You can associate the following types of permissions with a role. You can associate permissions with the role at this stage or you can choose to associate these later.

- **Global permissions** – Specifies permissions related to customers, entitlements, license models, reports and, service agreements. Refer to [Associating Read/Write Permissions with a Role](#) for details.
- **Namespace permissions** – Specifies permissions related to namespaces defined in system. Refer to [Associating Namespace Permission with a Role](#) for details.

   The **Catalog Permission** section displays namespaces created in the system; for example, *Computation Unit* in the pop-up shown above.

7. You can associate a user(s) with the role at this stage, or you can choose to do it later. To associate a user(s):
   a. Select a user(s) from the **Users Available** pane on the left.
   b. Click the right arrow (➡️) to move the user(s) to the **Users Associated** pane on the right.

   To disassociate a user from the role, select the user from the right pane and click the left arrow (⬅️).

   The users available in the right pane are associated with the roles.

8. Click **Submit**.

### 3.2. Associating Read/Write Permissions with a Role

1. On the main menu, click **Users > Roles**. The Roles page appears.
2. Select a role from the list on the left side of the page.
3. Click **Edit** on the right side of the page. The Edit Role page appears.
4. Under **Global Permissions**, you can set permissions for the following modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Permissions for the Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Management</td>
<td>■ None</td>
</tr>
<tr>
<td></td>
<td>■ View</td>
</tr>
<tr>
<td></td>
<td>■ View and Edit</td>
</tr>
<tr>
<td></td>
<td>■ View, Edit and Add</td>
</tr>
<tr>
<td></td>
<td>■ View, Edit, Add and Delete</td>
</tr>
<tr>
<td>Entitlement</td>
<td>■ None</td>
</tr>
<tr>
<td></td>
<td>■ View</td>
</tr>
<tr>
<td></td>
<td>■ View and Edit</td>
</tr>
<tr>
<td></td>
<td>■ View, Edit and Add</td>
</tr>
<tr>
<td></td>
<td>■ View, Edit, Add and Delete</td>
</tr>
<tr>
<td>License Model</td>
<td>■ None</td>
</tr>
<tr>
<td></td>
<td>■ View</td>
</tr>
<tr>
<td></td>
<td>■ View, Edit and Add</td>
</tr>
</tbody>
</table>
### Module Permissions for the Module

<table>
<thead>
<tr>
<th>Module</th>
<th>Permissions for the Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications</td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- View</td>
</tr>
<tr>
<td>Reports</td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- View</td>
</tr>
<tr>
<td>Service Agreements</td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- View</td>
</tr>
<tr>
<td></td>
<td>- View, Edit and Add</td>
</tr>
</tbody>
</table>

If *None* is selected for a menu item, then it won't be displayed in the screen for a user associated with this role.

**Example**

If you select *None* in **Customer Management** for a role, the user associated with this role will not see the **Customer** tab in the main menu. If you select **View and Edit**, the user associated with this role will see the **Customer** menu, can view and edit the customers and contacts, but cannot add or delete any customer or contact.

### 3.3. Creating a User

1. On the main menu, click **Users > Users**. The Users page appears.
2. Click **New** on the right side of the page. The Add User pop-up appears.
3. Enter a name for the user in the User ID field. (Required; Alphanumeric; Length: 4-30 characters.)

4. Enter the e-mail ID of the user in the E-mail field.

5. Select Login Allowed to allow the user to log on to EMS.

   Enter the values of Ref ID 1 and Ref ID 2 if required. You can enter information that identifies the user in a different system, for example, a User ID in your company's ERP system.

7. Enter the date after which the user login should be disabled in the Expires On field. Select Never to extend the date infinitely.

8. Enter a password for the user in the Password field. Repeat the password in the Confirm Password field. (Length: 6-30 characters; Required)

9. To allow administrative privilege to the user, select the Administrator check box.

   If you select this check box, you can skip the next step. That is, you need not associate any role with the user because the administrative user has complete permissions on all the modules of EMS.

10. You can associate roles with the user at this stage or you can choose to do it later. To associate a role:

    a. Select a role(s) from the Roles Available pane on the left.

    b. Click the right arrow ( ) to move the role(s) to the Roles Associated pane on the right.

    To disassociate a role from the user, select the role from the right pane and click the left arrow ( ).

11. Click Submit.

3.4. Associating Roles with a User

A non-administrative user must be associated with a role to be able to log in to EMS. To associate a role with the user:

1. On the main menu, click Users > Users. The Users page appears.

2. Select a user from the list on the left side of the page.

3. Click Edit on the right side of the page. The Edit User pop-up appears.

4. Under Associate Roles:

    a. Select a role(s) from the Roles Available pane on the left.

    b. Click the right arrow ( ) to move the role(s) to the Roles Associated pane on the right.

    To remove a role from the Role Associated pane, select the user and click the left arrow ( ).

    The roles available in the right pane are associated with the user.

5. Click Submit.
3.5. Managing Roles

3.5.1. Viewing All Roles

On the main menu, click **Users > Roles**. The Roles page appears. The left pane displays role names and their status.

![Roles page](image)

This is a read-only page. However, options are available in this page to perform the following operations:

3.5.2. Searching a Role(s)

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the second field.
3. Click ![search icon]. All the roles matching the search parameter are displayed.

3.5.3. Viewing the Details of a Role

Select a role from the left pane to view its details.

3.5.4. Editing a Role

1. Select a role from the left pane.
2. Click **Edit** on the right side of the page. The Edit Role pop-up appears. In this page, you can perform the following operations:
   - Enable/disable roles
   - Edit the description
   - Edit the permissions associated with the role
   - Associate users with the role
3. Click **Submit**.
3.5.5. Deleting a Role

1. Select a role from the left pane.
2. Click **Delete** on the right side of the page.

3.6. Managing Users

3.6.1. Viewing All Users

On the main menu, click **Users > Users**. The Users page appears. The left pane displays User IDs and their logon expiration date.

![Users (Total 1)](image)

This is a read-only page. However, options are available in this page to perform the following operations:

3.6.2. Searching Users

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the second field.
3. Click **Go**. All the user IDs matching the search parameter are displayed.

3.6.3. Viewing the Details of a User

Select a user from the left pane to view its details.

3.6.4. Editing User Details

1. Select a user from the left pane.
2. Click **Edit** on the right side of the page. The Edit User pop-up appears. In this page, you can perform the following operations:
   - Change the e-mail ID of the user
   - Change the password of existing users
Chapter 3: User Authorization

- Allow/deny login
- Edit RefID 1 and RefID 2
- Edit the logon expiration date
- Allow/deny administrative privilege to the user
- Associate/dissociate roles with the user

3. Click **Submit**.

3.6.5. Deleting a User

1. Select a user from the left pane.
2. Click **Delete** on the right side of the page.

3.6.6. About SFNTSupport User

Cloud EMS contains a pre-defined user **SFNTSupport**. This user can perform administrative functions similar to the **admin** user. The SFNTSupport user is meant to be used by the SafeNet Support team to help EMS administrator with troubleshooting, if required.

By default, the login is disabled for the SFNTSupport user. In cases where the EMS administrator seeks help from SafeNet, the EMS administrator should allow login for the SFNTSupport user and change its password. The SafeNet Support executive can then use these credentials to access EMS for troubleshooting.

**Enabling the SFNTSupport User**

1. On the **Users** page, click **SFNTSupport** in the left pane. Details of the SFNTSupport user are displayed.
2. Click **Edit** and modify the following setting in the **Edit User** dialog box:
   a. Select the **Login Allowed** check box.
   b. To change password, click the pencil icon next to **Password**; and type the new password in the **Password** and **Confirm Password** fields.
We recommend keeping the Never check box selected. But if required, you can specify an appropriate expiration time in the Expires On field.

- Ensure that the Administrator check box is selected.
- Do not associate SFNTSupport with any role as it may effect its permissions.

3. Click Submit.
This chapter is meant for the EMS Administrator or any person with administrative privileges. The topics covered are:

4.1. What is a Namespace? ................................................................. 22
4.2. Creating a Namespace ............................................................... 22
4.3. Associating Namespace Permission with a Role .......................... 23
4.4. Managing Namespaces .............................................................. 23
4.1. What is a Namespace?

Namespace acts as a logical partition for your EMS workspace. If you offer products for different category, you can maintain different namespaces for different categories. Each product category need not have a separate installation of EMS. You can configure your users in such a way that they would not be able to know the presence of other namespaces except their own in the EMS workspace.

An example…

Let’s say, your organization has the following three different product category and a product manager for each category.

- Antivirus and System Optimization Products
- Graphics Design Software Products
- Office Utility Software Products

You can create three different namespaces for the three product categories. For each namespace, you can assign a different product manager.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Namespace</th>
<th>Product Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antivirus and System Optimization Products</td>
<td>AVSO</td>
<td>PM1</td>
</tr>
<tr>
<td>Graphics Design Software Products</td>
<td>GD</td>
<td>PM2</td>
</tr>
<tr>
<td>Office Utility Software Products</td>
<td>OUSP</td>
<td>PM3</td>
</tr>
</tbody>
</table>

Each product manager can be given permission on only his concerned namespace. In other words, each product manager can define/package/manage products in his namespace.

4.2. Creating a Namespace

To create a namespace:

1. On the main menu, click **Catalog->Namespace**. The Namespace page appears.
2. Click **New** on the right side of the page. The Add Namespace pop-up appears.
3. Enter a name for the namespace in the Name field.
   You can enter up to 200 alphanumeric characters.

4. Enter the values of RefID 1 and RefID 2 if required. You can enter information that identifies the Namespace in your company’s ERP system.

5. Provide some brief information about the namespace in the Description box. It helps in identifying the namespace if similar-sounding namespaces are created later.

6. Click Submit.

### 4.3. Associating Namespace Permission with a Role

To associate namespace permissions with a role:

1. On the main menu, click Users > Roles. The Roles page appears.
2. Select a role from the list on the left side of the page.
3. Click Edit on the right side of the page. The Edit Role page appears.
4. Under Catalog Permissions, all the namespaces available in the EMS catalog are listed. Select the appropriate option to assign permission.
   You can assign view, edit, add, and/or delete permissions to a role on different namespaces.

### 4.4. Managing Namespaces

On the main menu, click Catalog>Namespaces. The Namespace page appears. The left pane displays the namespaces and their description.
This is a read-only page. However, options are available in this page to perform the following operations:

4.4.1. **Searching Namespaces**

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the second field.
3. Click ![search icon]. All the namespaces matching the search parameter are displayed.

4.4.2. **Viewing the Details of a Namespace**

Select a namespace from the left pane to view its details.

4.4.3. **Editing Namespace Details**

1. Select a namespace from the left pane.
2. Click **Edit** on the right side of the page. The Edit Namespace page appears.
3. Edit the namespace details as required. (You cannot change the namespace name.)
4. Click **Submit**.

4.4.4. **Deleting a Namespace**

Before deleting a namespace you must ensure that it is empty, else the catalog elements in the namespace will be deleted.

1. Select a namespace from the left pane.
2. Click **Delete** on the right side of the page.

**A namespace cannot be deleted if:**

- One or more roles are associated with the namespace.
- An entitlement is created for a product belonging to the namespace.
This chapter is intended for employees of your organization who are involved in conceptualizing product packaging and licensing plans. The typical user considered in this chapter is Product Manager.

Before packaging a product, your organization needs to work out a detailed licensing plan. Depending on this, you can make a decision on the license models to be used for your product. Packaging a product involves the following steps.

1. Add a license model to a feature
2. Associate the feature with a product
3. Associate the service agreement with a product

This chapter provides an overview about creating and managing features and products (called catalog elements). The catalog elements are always associated with a namespace. Access to a catalog element is based on the permissions defined in the roles.

The following topics are covered in this chapter:

5.1. What is a License Model? ................................................................. 26
5.2. What is a Service Agreement? ......................................................... 38
5.3. What is a Feature? .............................................................................. 41
5.4. What is a Product? ............................................................................ 42
5.5. Lifecycle of a Product ........................................................................ 43
5.1. What is a License Model?

A license model is a combination of various parameters that define how a product can be used by a customer. Sentinel Cloud EMS provides you the flexibility to add multiple license models to your product, so that you can generate different types of licenses according to your requirement.

License models map different license attributes into logical groups, which define how a software application is being deployed. You can also create your own license models by copying an existing license model and changing its attribute values.

**What does a License Model Contain?**

Each license model is a combination of the following parameters:

- **Enforcement Technology** - The available enforcement technology is Sentinel Cloud.

- **Attribute Groups** - When you select a license model from the list, its attribute groups are populated as separate tabs. The license models may have some or all of the following attribute groups:
  - Time
  - Usage Type
  - Capacity Attribute
  - Concurrency
  - Grace
  - Maximum Usage Limit
  - Vendor Attribute

- **Attributes** - These are generically defined properties (with name, data type, and possible range) that make a license. Attributes are explained in the subsequent section.

The following figure uses Postpaid license model as an example to illustrate attribute groups and attributes.
5.1.1. License Attributes

This section provides a comprehensive list of all the available license attributes. A license model usually contains a combination of these attributes. Based on these attributes, you may even define your own license models that meet your business requirements.

<table>
<thead>
<tr>
<th>License Attribute</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (License Validity)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td>The license start date and time. If a beginning date is chosen for a license, the feature cannot be used before that date and time. You can specify date in the dd/mm/yyyy format, and time in the hours:minutes format. DST is automatically applied to the license start/end date according to the customer time zone. The DST adjustment is applicable for the dates lying in years 2012 and 2013*. *This is because DST information is available till year 2013 only.</td>
<td>01/01/2012 00:00</td>
</tr>
<tr>
<td>End Date</td>
<td>The license expiration date and time. The license expires when the end date is reached. You can specify date in the dd/mm/yyyy format, and time in the</td>
<td>01/01/2014 23:59</td>
</tr>
<tr>
<td>License Attribute</td>
<td>Description</td>
<td>Default Setting</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>hours:minutes format. The end date can also be set to 'No Limit' (never expire). DST is automatically applied to the license start/end date according to the customer time zone. The DST adjustment is applicable for the dates lying in years 2012 and 2013*. *This is because DST information is available till year 2013 only.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Grace**

- **Grace Limit**: The additional number of days/times the feature can be used after its license has expired/exhausted.
  - For subscription licenses, range is 1 to 365.
  - For prepaid licenses, range is 1 to 2147483647.
- **Measurement Unit**: The unit to specify the grace limit.
  - Days for subscription
  - Count for prepaid

**Maximum Usage Limit**

- **Maximum Usage Limit**: The maximum number of times a feature can be used. Its range is 1 to 2147483647.
  - 100

**Concurrent Limit**

- **Concurrent Limit**: The maximum number of concurrent instances allowed for a feature.
The Concurrent Limit for a feature should be in the range 1-32752.
  - 10
- **Instance Counting**: The criteria of counting concurrent instances, which can be one of the following:
  - Per Login
License Attribute | Description | Default Setting
--- | --- | ---
- **Per Login** - Count each login request as an instance. If the same user logs in to a feature multiple times, each login will consume one concurrency limit.
- **Per Identity** - Count each user as an instance. All the login requests by the same user ID are counted as an instance, and consume only one concurrency limit.
- **Per Identity Per Station** - Count each user-machine pair as one session. All the login requests by the same user from the same machine are counted as one session, and consume only one concurrency limit.

If the user accesses the application from a terminal server, it contributes to an additional count.

**Concurrency Support for Deployment Models**
The following table specifies which counting types are supported for which deployment type:

<table>
<thead>
<tr>
<th>Counting Type</th>
<th>Cloud</th>
<th>On-premise Entitlement Level</th>
<th>On-premise Feature Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per Login</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Per Identity</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Per Identity per Station</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Usage Type**

<table>
<thead>
<tr>
<th>Usage Type</th>
<th>Data Aggregation for tracking usage. It can be of the following types:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- <strong>Count Based</strong>: Each login/logout pair is counted as one execution.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Time Based</strong>: Duration of each login session is aggregated.</td>
</tr>
</tbody>
</table>

| VENDOR ATTRIBUTE | Stores a vendor-defined value. For example, you can specify employee role or data download speed in this attribute. You can query vendor attribute values in a protected application (by using the getInfo Run-time API), and define application logic based on the outcome. | NULL |

**VENDOR ATTRIBUTE**

<p>| Vendor Attribute | Stores a vendor-defined value. For example, you can specify employee role or data download speed in this attribute. You can query vendor attribute values in a protected application (by using the getInfo Run-time API), and define application logic based on the outcome. | NULL |</p>
<table>
<thead>
<tr>
<th>License Attribute</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>EMS also allows generating the following reports based on the value specified in vendor attribute:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- <a href="#">Custom Vendor Attribute Report</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- <a href="#">Feature Usage Based on Vendor Attribute Report</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can enter up to 255 alphanumeric characters in this field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="#" alt="A vendor attribute is not used by Cloud Connect in license enforcement." /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Capacity Attribute</th>
<th>Description</th>
<th>Default Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity Attribute</td>
<td>Used to enable processing of capacity values recorded by an application for postpaid features. You must set Capacity Attribute in EMS if you want to be notified when your customers approach or reach a specified limit. You can define Capacity Attribute only for postpaid license models. The allowed range is 1 to 2147483647.</td>
<td>Null</td>
</tr>
<tr>
<td>Monitoring Usage and Generating Notifications</td>
<td>It is the limit beyond which you may want to monitor the feature usage. You can configure e-mail notifications to be sent when the Peak Capacity of a feature approaches or reaches the limit set in Capacity Attribute. The related notification rules available in EMS are: <a href="#">Capacity Peak Exceeded</a> and <a href="#">Capacity Peak Approaching</a>. In addition, you can also use the getInfo Run-time API to query capacity information, and implement decision making based on the response. For example, you can throw warning messages to user from within application on exceeding the limit set in Capacity Attribute.</td>
<td></td>
</tr>
<tr>
<td>About Capacity and Peak Capacity</td>
<td>Capacity, an integer value passed in a login session, is an indicator of load during the session. The load can have different meanings in different environments. It could be number of users consuming the application at a given time or the number of cores. Peak Capacity is the cumulative value of capacity. It indicates the cumulative load across a number of simultaneous sessions that are in use by a customer.</td>
<td></td>
</tr>
</tbody>
</table>
Overriding a License Attribute

While creating a license, you can set a license attribute to overridable, to allow its value to be changed at the time of entitlement generation.

Read Next:
Basic License Models

5.1.2. Basic License Models

EMS supports Sentinel Cloud as the enforcement technology, which provides various license models for provisioning your applications. The table below provides information about the available license models and their support on Cloud and On-premise deployments.

<table>
<thead>
<tr>
<th>License Model</th>
<th>Availability</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription</td>
<td>![Checkmark]</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>Post-paid</td>
<td>![Checkmark]</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>Concurrent</td>
<td>![Checkmark]</td>
<td>![Checkmark]</td>
</tr>
<tr>
<td>Pre-paid</td>
<td>![Checkmark]</td>
<td>Not Available</td>
</tr>
</tbody>
</table>

Table: Supported License Models

<table>
<thead>
<tr>
<th>License Model</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscription</td>
<td></td>
</tr>
<tr>
<td>Post-paid</td>
<td></td>
</tr>
<tr>
<td>Concurrent</td>
<td>The supported counting types are <strong>Per Login</strong> and <strong>Per Identity</strong>.</td>
</tr>
<tr>
<td>Pre-paid</td>
<td></td>
</tr>
</tbody>
</table>

Subscription

The Subscription license model specifies that license to use the product is valid for a specified duration (for example, 6 months). The product can be used any number of times within the specified duration.

You can also define a grace period that allows use of the subscription-based license after the end date has been reached. The grace period provides an additional time for an end user to get the license.
renewed. You can use the Run-time API, `getInfo`, to send notifications to end users about the grace period. For details of the `getInfo` API, refer to the Cloud Run-time Guide.

The attributes of Subscription license model are Start Date, End Date, Grace Limit, Measurement Unit, Usage Type (Time Based by default), and Vendor Attribute. For details of attributes, see License Attributes.

**Post-paid**

The Post-paid license model specifies that the license to use the product is valid for a specified duration. However, the billing can be done based on the usage model, which can either be:

- **Time Based**: Billing can be done based on the duration of period for which the product is used.
- **Count Based**: Billing can be done based on the number of times the product is used within the specified period.

The attributes of Post-paid license model are Start Date, End Date, Usage Type (Default is Time Based), Vendor Attribute, and Capacity Attribute. For details of attributes, see License Attributes.

**Pre-paid**

The Pre-paid license model specifies a limit on the maximum number of times a license can be used, in addition to license validity.

You can define a grace limit that allows use of a prepaid feature even after the maximum usage count has exhausted. The grace limit provides additional time to an end user to get the license renewed. You can use the Run-time API, `getInfo`, to send notifications to end users about the grace limit. For details of the `getInfo` API, refer to the Cloud Run-time Guide.

The attributes of Prepaid license model are Start Date, End Date, Grace Limit, Measurement Unit, Maximum Usage Limit, and Vendor Attribute. The usage model is Count Based; however, the usage data is not used for billing. For details of attributes, see License Attributes.

**Concurrent**

It is a subscription-based license model in which there is a limit on the concurrent use of a feature. You can specify the number of concurrent instances allowed for a feature, and select how concurrent instances are counted.

The attributes of Concurrent license model are Start Date, End Date, Concurrent Limit, Instance Counting, Usage Type (Default is Time Based), and Vendor Attribute. For details of attributes, see License Attributes.

**See Also:**

Viewing All License Models

**Possible License Model Strategies**

The attribute values of pre-defined license models can be customized to create a variety of license strategies to suit your requirements. The key parameters that play a major role in creating a new license strategy are:
- **Type of entitlement** - Defines the behavior at entitlement level
- **Attributes of License Model** - Defines the behavior at feature level

This section describes the license strategies that you can offer to your Retail and Enterprise customers.

To create the license models defined in this section, take a pre-defined license model as base and modify its attribute values. See [Creating a License Model by Copying an Existing One](#).

**Considerations:**

- Retail entitlements are always named.
- Start Date and End Date are mandatory attributes across all the license models.
- Local/Global Availability of license - There are few license models for which Authorization Map\(^1\) is pushed to Sentinel Cloud Run-time and their authorization requests can be served locally from cache (for a specific duration). For other license models (also called 'globally concurrent licenses'), each requests must be sent from Sentinel Cloud Run-time to Sentinel Cloud Connect.

License Models for which each request is sent to Sentinel Cloud Connect are more expensive to implement than the locally available licenses (inexpensive).

EMS provides you a license modeling experience that takes advantage of a combination of Mandatory and Advanced license model types.

**Table 1: Mandatory Attribute Sets**

The table below lists the mandatory set of attributes for creating a license.

<table>
<thead>
<tr>
<th>Type of Entitlement</th>
<th>Description</th>
<th>Named</th>
<th>Unnamed</th>
<th>Number of Users</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
</table>
| Retail              | Single Named User  
                    | Validity of license is controlled by Start and End Date | Yes | NA | 1 | Yes | Yes |
| Enterprise Named    | Limited number of named users  
                    | Validity of license is controlled by Start and End Date | Yes | NA | >=1 | Yes | Yes |
| Enterprise Unnamed  | Any number of users in an enterprise  
                    | Validity of license is controlled by Start and End Date | NA | Yes | NA | Yes | Yes |

\(^1\) The set of authorized features per user.
Table 2: Advanced License Model Types

You can combine the mandatory attribute set given in Table 1 with any of the advanced license model given in this section, to create a variety of customized license model for yourself.

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Description</th>
<th>Maximum Count</th>
<th>Concurrent Limit</th>
<th>Usage Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Paid Count</td>
<td>Limited number of executions of a feature</td>
<td>Yes</td>
<td>No</td>
<td>Count</td>
<td>Expensive</td>
</tr>
<tr>
<td>Post-Paid Count</td>
<td>Unlimited number of executions tracked through usage data</td>
<td>No</td>
<td>No</td>
<td>Count</td>
<td>Inexpensive</td>
</tr>
<tr>
<td>Post-Paid Time</td>
<td>Unlimited usage time. Time consumed can be tracked through usage data</td>
<td>No</td>
<td>No</td>
<td>Time</td>
<td>Inexpensive</td>
</tr>
<tr>
<td>Subscription</td>
<td>Unlimited usage valid for the subscription period</td>
<td>No</td>
<td>No</td>
<td>Any</td>
<td>Inexpensive</td>
</tr>
<tr>
<td>Concurrency</td>
<td>Maximum number of concurrent instances of a feature</td>
<td>No</td>
<td>Yes</td>
<td>Any</td>
<td>Expensive</td>
</tr>
</tbody>
</table>

For example, you can pick Retail set from Table 1 and combine it with license models give in Table 2 to create the following license models:

- Retail Pre-Paid Count
- Retail Post-Paid Count
- Retail Post-Paid Time
- Retail Subscription
- Retail Concurrency

5.1.3. Viewing All License Models

On the main menu, click Catalog > License Models. The License Models page appears.
EMS provides a number of standard license models that are suitable for most of your licensing requirements. However, if you have some specific requirements, you can customize the existing license models by copying and editing an existing one.

### 5.1.4. Creating a License Model by Copying an Existing One

The pre-defined license models in EMS provide a fixed set of attributes. You can create your own license model by copying an available license model and customizing the values of its attributes. For example, you can create a time-based license model that is valid till a specific date.

The steps to create a license model are as follow:

1. On the main menu, click Catalog > License Models. The license Models page appears.
2. Select a license model from the left pane.
3. Click Copy on the right side of the page. The Add License Model pop-up appears.

   The attributes list varies with license model. The following figure shows the Add License Model pop-up for the postpaid license model.
4. Enter a name for the new license model in the **New License Model Name** box. You can enter up to 255 alphanumeric characters.

5. Add a description for the license model in the **Description** field. You can enter up to 510 alphanumeric characters.

6. Enter the values of **Ref ID 1** and **Ref ID 2** if required. You can enter information that identifies the license model in a different system, for example, a License Model ID in your company's ERP system.

7. Click to expand the panes under **Attributes List**.

8. Edit the default values of the attributes as required. For attribute description, see License Attributes.

   For each of the available attributes, the **Overridable** check box is selected. This indicates that the attribute value can be changed by the Contract Operator at the time of entitlement generation. If you do not want to allow the Contract Operator to change an attribute value, clear the corresponding **Overridable** check box.

9. Click **Save**.

### 5.1.5. Examples On Creating Licenses

This section provides a few examples of license generation for popular license models.
The options and values provided in the examples below are kept simple for getting started. These might not match with the actual requirements of your customers. You can, however, choose settings depending on your requirements.

Creating a Perpetual License

A perpetual license model is used to create subscription products where there is no limit on the duration for which the product can be used. License models with very large duration (example, 17 years or more) are considered as perpetual.

To create a perpetual license model:

1. Copy the Subscription license model.
2. In the New License Model Name field, enter the name of new license model. Specify a Description, as required.
3. Under the Time group, Select the No Limit check box adjacent to the End Date field.
4. Clear the Overridable check box. This will ensure that the contract operator will not change the end date at the time of creating an entitlement.
5. Click Save.

Creating a Count-based Post-paid License

Let's say that you want to create a postpaid license model which is valid for specific duration. You want the billing to be done based on the number of times a feature of product is consumed. The steps to create such a license model are:

1. Copy the Postpaid license model.
2. In the New License Model Name field, enter the name of new license model. Specify a Description, as required.
3. Under the Time group, specify date and time in the Start date field, say 8/18/2012 00:00.
4. From the End date field, specify a date that is ahead the start date, say 5 years. It is 8/18/2017 23:59 in our example.
5. Under the Usage Type group, select Count Based.
6. Click Save.

Creating a Subscription License with Controlled Concurrency

Let's say that you want to allow all the employees of a company to access a particular feature of a product. But, you want to ensure that a feature usage at any point of time should not exceed 10 concurrent users or 10 concurrent login sessions. In such a scenario, you can choose the Concurrent license model.

The steps to create Concurrent license model are:

1. Copy the Concurrent license model.
2. In the New License Model Name field, enter the name of new license model. Specify a Description, as required.
3. Under the **Time** group, select appropriate **Start date** and **End date**.
4. In the **Concurrent Limit** field, specify the maximum number of concurrent instances you want to allow for a feature.
5. From the **Counting Type** drop-down list, select how concurrent instances are counted.
6. Under the **Usage Type** group, specify a usage type as required.
7. Click **Save**.

### Creating an On-premise Feature Level License with Controlled Concurrency

1. Copy the **Concurrent** license model.
2. In the **New License Model Name** field, enter the name of new license model. Specify a **Description**, as required.
3. Enter the values of **Ref ID 1** and **Ref ID 2** if required. You can enter information that identifies the license model in a different system, for example, a License Model ID in your company's ERP system.
4. Under the **Time** group, select appropriate **Start date** and **End date**.
5. In the **Concurrent Limit** field, specify the maximum number of concurrent sessions you want to allow for a feature.
6. From the **Counting Type** drop-down list, select **Per Identity Per Station**.
7. Under the **Usage Type** group, specify a usage type as required.
8. Click **Save**.

### 5.2. What is a Service Agreement?

Service Agreement refers to a mutual agreement between a software provider and a customer. This agreement defines various attributes of products being offered, such as level of quality, performance, availability, etc.

In EMS, a service Agreement is used to record **Data Aggregation**\(^1\) frequency, which defines the time interval after which the usage data is aggregated. The raw usage records are collected by Sentinel Cloud Run-time and are pushed to Sentinel Cloud Connect at the defined frequency. Sentinel Cloud Connect aggregates the multiple records into one single record in every 24 hours. The aggregated records form the basis for generating bills. Aggregated records are used in EMS to present usage and billing data to software provider/customer.

A service agreement is defined at the entitlement level and is applicable to all the products (and features) belonging to an entitlement.

EMS provides a built-in service agreement with some pre-defined attributes. You can create your own service agreements by copying the existing service agreement and changing its attributes.

---

\(^1\)Process of converting raw usage data into processed data that can be used for billing and metering.
5.2.1. Viewing All Service Agreements

On the main menu, click **Catalog > Service Agreement**. The Service Agreement page appears.

EMS provides a standard service agreement template that you can copy and customize according to your requirements.

5.2.2. Creating a Service Agreement by Copying an Existing One

The pre-defined service agreement in EMS provides a fixed set of Data Aggregation\(^1\) attributes that is used for billing purposes. You can copy it to create your own service agreement, as described below:

1. On the main menu, click **Catalog > Service Agreement**. The Service Agreements page appears.
2. Select a service agreement from the left pane.

---

\(^1\) Process of converting raw usage data into processed data that can be used for billing and metering.
3. Click **Copy** on the right side of the page. The Add Service Agreement pop-up appears.

![Add Service Agreement](image)

4. Enter a name for the new service agreement in the **New service agreement Name** box. It is a mandatory field. You can enter up to 255 alphanumeric characters.

5. Add a **Description** for the service agreement. You can enter up to 500 alphanumeric characters.

6. Enter the values of **Ref ID 1** and **Ref ID 2** if required. You can enter information that identifies the Service Agreement in your company’s ERP system.

7. Click to expand the **Preferences** pane, and modify the default value of attributes as required. From the **Frequency** drop-down list, select the minutes after which the usage data is aggregated.

   By default, the **Overridable** check box is selected. This indicates that the attribute value can be changed by the Contract Operator at the time of entitlement generation. If you do not want to allow the Contract Operator to change an attribute value, clear the corresponding check box.

8. Click **Submit**.

9. Click to expand the panes under **Attributes List**, and modify the default value of attributes as required.
5.3. What is a Feature?

A feature is a distinct functionality of a software application that can be independently licensed. Features are the basic building blocks of a product. One or more features can be bundled into a product according to your product marketing model. In other words, you can break down your products to different usable features. By doing this, you can give your customers the flexibility to purchase only those features and capabilities of your product that they actually need.

You can define a feature on any of the following:

- A complete application
- A module of a product
- A specific functionality

A feature is not a saleable entity, and it needs to be part of a product.

*Example*

You want to create a product PDFMaker. You can configure the following four features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>PDF Reader</td>
</tr>
<tr>
<td>F2</td>
<td>PDF Maker</td>
</tr>
<tr>
<td>F3</td>
<td>PDF Editor</td>
</tr>
<tr>
<td>F4</td>
<td>PDF to Word Converter</td>
</tr>
</tbody>
</table>

You may choose to roll out the following flavors of the same product to the market.

- PDFMaker Premium (F1, F2, F3, F4)
- PDFMaker Pro (F1, F2, F3,)
- PDFMaker Home (F1, F2)

5.3.1. Feature Level Authorization

In Sentinel Cloud, the authorization is done at feature level. A user is authorized before granting rights for a feature. To implement the authorization functionality, the authorization Run-time APIs are integrated in your application. These APIs use the unique feature identifiers (*feature name* and *feature ID*, explained below), thus the feature identifiers become very critical to the process of license enforcement. These must remain same in EMS and your application. You can implement authorization based on either feature ID or feature name.

What does a Feature Contain?

A feature contains the following attributes:
- **Feature ID:** This is explained in the section below.
- **Feature Name:** This is explained in the section below.
- **License Model:** Each feature is associated with one or more license model. For details, see License Models.

**About Feature ID**

Each feature is assigned a unique integer, called feature ID.

**Defining a Feature**

While defining a new feature in EMS, you can choose to enter a feature ID of your choice or generate it automatically.

- **Specify ISV Specific Value:** If you want to integrate your existing ERP or back-office system with EMS, you will need to specify the feature IDs. These feature IDs should be same as the IDs you have used in the ERP or back-office system.

- **Generate Automatically:** If there is no existing ERP or back-office system to integrate with EMS, you should auto-generate the feature IDs. Ensure to use the same feature IDs in your application as are used in Run-time APIs or web service calls.

**Consuming a Feature (Run-time/Cloud Connect Web Service Integration)**

The feature ID that you define in EMS is used during the integration of your application with Run-time or Cloud Connect Web services. In this case, the feature ID is used to enforce authorization at the feature level.

**About Feature Name**

Similar to feature ID, each feature is assigned a unique feature name. It is a user-friendly, easy-to-remember name of the feature. The feature ID is an integer whereas feature name is a string value.

**Consuming a Feature (Run-time Integration)**

You may also use feature name instead of feature ID during the integration of your application with Run-time. In this case, the feature name is used to enforce authorization at the feature level.

Either feature ID or feature name should be used during the integration of your application with Run-time, and it should be done consistently. Using both interchangeably is not supported.

**5.4. What is a Product?**

A product is a combination of individual features, each of which is associated with one or more license models. It can be a software application that can be ordered or licensed according to your licensing plan.
As you cannot sell a feature directly, you will need to bundle it in a product to make it saleable. License models are defined for each feature in a product. Typically, this function is performed by the product manager, and implemented by the software engineer. The implementation scenario can be one of the following:

- You create a common product with all the related features bundled. The contract operator can enable/disable products while producing the order. The features in the product can be controlled without changing its code by different license models.
- You can define a number of products with combination of different features by understanding the market requirements and keep them ready for order.

**What does a Product Contain?**

A product is composed of following attributes:

- **Service Agreement**: While creating a product, a service agreement is associated with it which defines the level and quality of product. For more information, refer to the topic "What is a Service Agreement?".
- **Features and License Models**: Each product is a set of one or more feature. Each feature is associated with one or more license model.

---

**5.5. Lifecycle of a Product**

Lifecycle refers to the different stages of a product. The different stages of a product are:

- **Draft**: When a product is first created it remains in Draft stage. In this stage, you can edit or delete the product. However, entitlements cannot be created for a Draft product.
  
  Draft products are represented with orange icons (🟠) in the products list
  
- **Complete**: In this stage, you can create entitlements for the product. However, updating or disabling a feature or changing features associated with the product is not allowed.
  
  Complete products are represented by green icons (🟢) in the products list.
End of Life (EOL): When a product becomes obsolete, you can mark the lifecycle stage of the product as End of Life. In this stage, you can neither add any new features to the product, nor create entitlements for the product. However, the product details remain in the system for pre-existing catalogs/entitlements.

EOL products are represented by light gray icons (_idle) in the products list.

Create Product → Draft → Complete → End of Life

Stages in the lifecycle of a product

5.5.1. Marking a Product as Complete
To mark a Draft (or End of Life) product as Complete:

1. Select the product from the left pane.
2. Click Complete on the right side of the page.

The Complete button is visible only for the products in the Draft stage.

5.5.2. Marking a Product as End of Life (EOL)
To mark a Complete product as EOL:

1. Select the product from the left pane.
2. Click End of Life on the right side of the page.

The End of Life button is visible only for the products in the Complete stage.

5.6. Creating a Feature
To create a feature:

1. On the main menu, click Catalog > Features. The Features page appears.
2. Click New on the right side of the page. The Add Feature pop-up appears.
3. Select the namespace to which the feature should belong from the **Namespace** drop-down list.

4. Enter a unique name for the feature in the **Feature Name** field.

   You can enter up to 50 alphanumeric characters, except the following: <,>,%,&," and [,].

   The feature name should not be duplicate for an ISV. It should be unique across all namespaces of a customer.

5. Assign a unique **feature ID** to the feature. To generate a feature ID, select the **Auto Generate Feature Id** check box. Alternatively, clear the check box and enter the ID in the **Feature Id** text box. Only integers are allowed.

   **Please note:**
   - The feature ID should be same as the feature ID used to identify a feature in the ISV application.
   - For on-premise entitlements, the feature ID should be in the range 1-65471. For Cloud applications, the feature ID should be in the range 1-999999.

6. Enter the values of **Ref ID 1** and **Ref ID 2** if required. You can enter information that identifies the Feature in a different system, for example, a Feature ID in your company's ERP system.

7. Add a description to the feature in the **Description** box.

   You can enter up to 500 alphanumeric characters.
8. Select the enforcement technology and its version from the Enforcement drop-down list.

9. Associate license models with the feature:
   a. Select a license model(s) from the License Models Available pane on the left.
   b. Click the right arrow (➡️) to move the license model(s) to the License Model Associated pane on the right.
      To disassociate a license model from the feature, select the license model from the right pane and click the left arrow (⬅️).
   c. At least one license model has to be associated with a feature. If you have added multiple license models with a feature, mark one of them as default by selecting the radio button under the Default column.

10. If any custom attributes are available for the feature entity, the Custom Attributes section appears towards the end of the pop-up. Specify the custom attributes values, as required.

11. Click Submit.

5.7. Associating License Model with a Feature

To make a feature usable, you need to link it to one or more license models. You can also mark one of the license models as default. Before entitlement generation, you can choose one of the license models linked with the feature.

To associate license models with a feature (that has not been deployed):

1. On the Catalog menu, click Features.
2. Select the feature from the list.
3. Click Edit. The Edit Feature pop-up appears.
4. To associate license models with the feature:
   a. Select a license model(s) from the License Models Available pane on the left.
   b. Click the right arrow (➡️) to move the license model(s) to the License Model Associated pane on the right.
      To disassociate a license model from the feature, select the license model from the right pane and click the left arrow (⬅️).
   c. At least one license model has to be associated with a feature. If you have added multiple license models with a feature, mark one of them as default by selecting the radio button under the Is Default column.

5. Click Submit.

You cannot remove the license models associated to a feature, which is already deployed. For a deployed feature, the Edit button is not available.
5.8. Creating a Product

To create a product:

1. On the main menu, click Catalog > Products. The Products page appears.
2. Click New on the right side of the page. The Add Product pop-up appears.

3. Select the namespace to which the product should belong from the Namespace drop-down list.
4. Enter a name for the product in the Product Name field.
   You can enter up to 50 alphanumeric characters; except the following: <, $, >, %, &, ^, ", [ ], \.
5. Enter a version number in the Version field.
   You can enter up to 20 alphanumeric characters; except the following: <, >, $, %, &, ^, ", [ ], \.
Duplicate "product name + version" combination is not allowed in a namespace.

6. Enter the values of Ref ID 1 and Ref ID 2 if required. You can enter information that identifies the Product in a different system, for example, a Product ID in your company’s ERP system.

7. Add a description for the product in the Description box. You can enter up to 500 alphanumeric characters.

8. Select the service agreement that you want to associate with the product from the Service Agreements drop-down list.

9. You can add features to this product at this stage or you can choose to add these later. To associate features with the product:
   a. Select a feature(s) from the Features Available pane on the left.
   b. Click the right arrow (>) to move the feature(s) to the Features Associated pane on the right.
   c. If you want to provide contract operator the ability to include or exclude a feature at the time of entitlement creation, select the corresponding Excludable check box. This allows to sell different feature combinations for a single product.
      By default, the Excludable check box is clear indicating that the feature is mandatory in the product.
   d. If you select Excludable, the Default Value drop-down list gets enabled. Select on/off to indicate if the feature is included/excluded by default.

   To disassociate a feature from the product, select the feature from the right pane and click the left arrow (ملك).

10. If any custom attributes are available for the product entity, the Custom Attributes section appears towards the end of the pop-up. Specify the custom attributes values, as required.

11. Click Submit. The product is created with lifecycle stage Draft. You can edit this product as many times as you want before changing its stage to Complete.

12. To make the product available for an entitlement, select it from the left pane and click Complete.

**5.9. Associating Features with a Product**

You can associate features with a product when it is in Draft stage. To associate features:

1. On the Catalog menu, click Products.
2. Select the product from the list.
3. Click Edit. The Edit Products pop-up appears.
4. To associate features with the product:
   a. Select a feature(s) from the Features Available pane on the left.
   b. Click the right arrow (→) to move the feature(s) to the Features Associated pane on the right.
   c. If you want to provide contract operator the ability to include or exclude a feature at the time of entitlement creation, select the corresponding Excludable check box. This allows to sell different feature combinations for a single product.
      By default, the Excludable check box is clear indicating that the feature is mandatory in the product.
   d. If you select Excludable, the Default Value drop-down list gets enabled. Select on/off to indicate if the feature is included/excluded by default.

To disassociate a feature from the product, select the feature from the right pane and click the left arrow (←).

5. Click Submit.

5.10. Associating a Service Agreement with a Product

At the time of creating a product, a service agreement is associated to it. You can change the associated service agreement if the product is in Draft stage. The steps to do so are:

1. On the main menu, click Catalog > Products. The Products page appears.
2. Select the product from the list.
3. Click Edit. The Edit Product pop-up appears.
4. Select a service agreement from the Service Agreements drop-down list.
5. Click Submit.
5.11. Managing Features

5.11.1. Viewing All Features

On the main menu, click **Catalog > Features**. The Features page appears.

The left pane displays feature names and their deployment status. The deployment status of a feature can be one of the following:

- **Draft**: Indicates that the feature is not associated to any product. The draft features are represented by orange icons (■).
- **Deployed**: Indicates that the feature is part of a draft or reconfigured entitlement. The deployed features are represented by green icons (■).

This is a read-only page. However, options are available in this page to perform the following operations:

5.11.2. Searching a Feature(s)

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the next field.
3. Click ![search icon]. All the features matching the search parameter are displayed.

5.11.3. Viewing the Details of a Feature

Select a feature from the left pane to view its details.
5.11.4. Editing the Feature Details

You can edit details of a feature irrespective of its deployment status.

You can add additional license models to a deployed feature, but cannot remove the license models that are already associated.

You can check the deployment status from the Status column in the left pane.

To edit a feature:

1. Select a feature from the left pane.
2. Click Edit on the right side of the page. The Edit Feature pop-up appears.
3. You can edit the following details:
   a. RefId
   b. Description
   c. License Models associated to the feature
   d. Custom attributes values, if available.
4. Click Submit.

5.11.5. Deleting Feature(s)

You can delete a feature only if it is not Deployed, that is, the feature is not used in any product. You can check the deployment status from the Status column in the left pane. To delete a feature:

1. Select a feature from the left pane.
2. Click Delete on the right side of the page.
5.12. Managing Products

5.12.1. Viewing All Products

On the main menu, click **Catalog > Products**. The Products page appears. The left pane displays product names and their deployment status.

![Products (Total 3)](image)

This is a read-only page. However, options are available in this page to perform the following operations:

5.12.2. Searching a Product(s)

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the second field.
3. Click **search**. All the products matching the search parameter are displayed.

5.12.3. Viewing the Details of a Product

Select a product from the left pane to view its details.

5.12.4. Editing Product Details

You can edit details of a product if:

- It is in **Draft** stage, or
- It is in **Complete** stage but not deployed on **Cloud Connect**.

You cannot edit namespace, name, and version of the product.

To edit product details:
1. Select a product from the left pane.
2. Click Edit on the right side of the page. The Edit Product pop-up appears.
3. After editing the required fields, click Submit.

5.12.5. Deleting a Product
You can delete a product only when it is in Draft stage.

1. Select a product from the left pane.
2. Click Delete on the right side of the page.
3. Click Yes to confirm the deletion.
Customers and Contacts

This section provides an overview on how you can manage customers and contacts. The following topics are addressed here:

6.1. What is a Customer? ............................................................... 56
6.2. What is a Contact? ................................................................. 56
6.3. Creating a Customer .............................................................. 57
6.4. Managing Customers ............................................................ 59
6.5. Creating a Contact ............................................................... 60
6.6. Managing Contacts .............................................................. 63
6.1. What is a Customer?

A customer is an individual or organization that owns an entitlement. A customer can have multiple contacts.

6.1.1. About Customer Reference ID

The customer entity exists in both EMS and ISV application. You need to link each other with a unique code that can identify a customer uniquely in EMS and ISV application. This unique code is called Customer Reference ID. It should be same in both EMS and ISV application. The customer reference ID can be system-generated or specified manually, as explained below:

- **System-generated**: An ID is generated by EMS that need to be maintained in your ISV application. There are two ways of generating it:
  - **GUID**: A random Globally Unique Identifier (GUID) is generated for the customer.
  - **Auto-increment**: A unique value is generated by incrementing the last Customer Ref ID.

- **Manually enter the customer reference ID**: Specify the ID that you have used in your ISV application for identifying the customer in EMS.

**Tip:**

We recommend using **GUID** because it randomizes Customer Ref IDs and thus provides security against theft or misuse of licenses.

**Benefit of Customer Reference ID**

The customer reference ID allows you to have duplicate customer names in EMS. Also if a customer name is modified in either ISV application or in EMS, the application's integration point does not break because Run-time works on customer reference ID only.

**Sentinel Cloud Run-time login, getInfo, and transfer API calls use customer reference ID.**

6.2. What is a Contact?

A contact is an individual who is the single point of contact for an entitlement. For retail customers, it is suitable to create contacts and generate entitlements for them. All the e-mails related to an entitlement are sent to the e-mail address specified for the contact.

An contact can be of one of the following types:

- **Primary**: Refers to the person who manages secondary contacts, in addition to the functions specified **here**. The primary contact can add, associate, remove, edit, and delete other
contacts after logging-in to EMS.

- **Secondary**: A new contact is added as secondary by default. It can only perform the functions specified [here](#).

### 6.3. Creating a Customer

1. On the main menu, click **Customers > Customers**. The Customers page appears.
2. Click **New** on the right side of the page. The **Create New Customer** pop-up appears.

![Create New Customer](image)

3. Enter a name for the customer in the **Customer Name** field. A maximum of 255 alphanumeric characters are allowed. You can also enter special characters, except “<” and “>”. Duplicate customer names are allowed.

   If a customer with the specified name already exists, a message is displayed to confirm if you want to create customer with the specified name or not.

4. Select the **Enabled** check box to allow the contacts within a customer account to log on to EMS.
5. From the **Customer Ref ID Type** drop-down list, select one of the following:
   a. **Manual**: Select if you want to enter Customer Ref ID manually.
   b. **Auto Increment**: Select if you want to generate Customer Ref ID automatically. The value is obtained by adding 1 to the last generated Customer Ref ID.
   c. **GUID**: Select if you want to generate a random Globally Unique Identifier (GUID) for the customer.
6. If you have selected Manual from the Customer Ref ID Type drop-down (step above), enter a unique identification code for the Customer in the Customer Ref ID field. A maximum of 255 alphanumeric characters are allowed. You can also enter special characters, except “<” and “>”.

7. Enter Ref ID.

8. Enter a description for the customer in the Description field.

9. Select the time zone of the customer from the Time Zone drop-down list. This ensures availability of licenses to the customer in the preferred time zone.

10. If you want to create a new contact for this customer:
   a. Select the Create Contact check box. The Contact Details, Billing Details\(^1\), and Shipping Details\(^2\) panes appear.
   b. Specify the contact details. For field-related information, see Creating a Contact.

11. If any custom attributes are available for the customer entity, the Custom Attributes section appears towards the end of the pop-up. Specify the custom attributes values, as required.

12. Click Submit.

---

\(^1\)Refers to the address registered on your credit card. In simple words, it is the address where you receive the statements for your credit card. For your order to be approved when shopping online, the billing address provided by you has to match this address.

\(^2\)Refers to the address where you want to receive your orders. It could be your home or office.
6.4. Managing Customers

In this section, you will learn how to add customers, edit their details, and delete a customer from the list.

6.4.1. Viewing All Customers

On the main menu, click **Customers** > **Customers**. The Customers page appears. The customer names and their details are displayed in the left pane.

This is a read-only page. However, options are available in this page to perform the following operations:

6.4.2. Searching Customers

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the second field.
3. Click **Search**. All the customer names matching the search parameter are displayed.

6.4.3. Viewing the Details of a Customer

Select a customer from the left pane to view its details.

6.4.4. Editing Customer Details

1. Select a customer from the left pane.
2. Click **Edit** on the right side of the page. The **Edit Customer** pop-up appears.
3. Edit the fields, as required. You can edit the following:
   - Customer Name
   - Ref ID
   - Description
   - Time Zone (editable only if an entitlement has not been created for the customer)
   - Custom attribute values, if available.

   For field information, refer to Creating a Customer.

   **CAUTION**
   You cannot change the Customer Ref ID after a customer has been created. This is because it is used in binding an ISV application with EMS.

5. Click Submit.

### 6.4.5. Deleting a Customer

A customer can be deleted if entitlements are not generated for him.

1. Select a customer from the left pane.
2. Click Delete on the right side of the page.
3. Click Yes to confirm the deletion.

### 6.5. Creating a Contact

You can create a new contact in the following ways:

- On the Contacts page, click New. This allows you to create a new contact for any customer.
- On the Customers page, under the Contact Association group, click Add Contact. This allows you to create a new contact for the selected customer.
- On the Entitlements page, under the Contact Association group, click Create Contact. This allows you to create a new contact for the selected customer.

Given below are the steps of creating a contact:
1. Use any of the methods described above to access the **Create New Contact** screen.

![Create New Contact Screen](image)

3. Enter the customer name to which the contact should belong in the **Customer Name** field. This field is editable only if you are creating a new contact from the **Contacts** page (method 1).

   You can also leave this field blank and specify the customer name later. See section **Editing Contact Details**, step 2(a) for more information. Once specified, the customer name associated with the contact cannot be changed.

4. In the case of duplicate customer names, a pop up window is displayed that shows reference IDs for duplicate customer names. Select the customer name with the desired reference ID, and click **OK**.

5. Enter the e-mail address of the contact in the **Contact E-Mail** field.

6. If you want to create a primary contact, select the **Is Primary** check box. By default, Cloud EMS creates a secondary contact. To know about primary/secondary contact, see **What is a Contact**.

7. Enter the telephone number of the customer in the **Contact No.** field.

8. Enter a name for the contact in the **Contact Name** field.

9. Enter the values of **RefID 1** and **RefID 2** if required. You can enter information that identifies the contact in a different system, for example, a Product ID in your company’s ERP system.

10. Select the **Login Allowed** check box to allow the contact to login to EMS. The system will prompt you to create a password for this contact.
11. Enter the password in the Password and Confirm Password fields.

12. Enter the Billing Details and Shipping Details.

13. If any custom attributes are available for the contact, the Custom Attributes section appears towards the end of the pop-up. Specify the custom attributes values, as required.

14. Click Submit.

---

1Refers to the address registered on your credit card. In simple words, it is the address where you receive the statements for your credit card. For your order to be approved when shopping online, the billing address provided by you has to match this address.

2Refers to the address where you want to receive your orders. It could be your home or office.
### 6.6. Managing Contacts

#### 6.6.1. Viewing All Contacts

On the main menu, click **Customers > Contacts**. The **Contacts** page appears. The contact names and their details are displayed in the left pane.

The Contacts page is read-only. However, options are available in this page to perform the following operations:

#### 6.6.2. Searching Contacts

1. In the left pane, select a search criteria from the **Search** drop-down list.
2. Enter a value for the search in the second field.
3. Click **Search**. All the contact names matching the search parameter are displayed.

#### 6.6.3. Viewing the Details of a Contact

Select a contact from the left pane to view its details.

#### 6.6.4. Editing Contact Details

You can edit a contact details in any of the following ways:

- On the **Contacts** page, select a contact in the left pane and click **Edit**.
- On the **Customers** page, under the **Contact Association** group, click the name of the contact you want to edit. A screen is displayed showing the contact details. Click **Edit**.
- On the **Entitlements** page, under the **Contact Association** group, click the name of the contact you want to edit. A screen is displayed showing the contact details. Click **Edit**.

To edit a contact:
1. Use one of the method given above to open the Edit Contact pop-up.

2. Do one or more of the following:
   
   a. **To specify a customer name (if not already specified)**, enter the name of the customer that you want to associate with the contact in the Customer Name field. Also specify the Customer Ref ID.

   Specifying customer name for a contact is a one-time step. Once specified, the customer name associated with the contact cannot be changed (until the contact is deleted).

   b. **To edit the shipping address**, enter values in the fields under Shipping Details\(^1\).

   c. **To edit the billing address**, enter values in the fields under Billing Details\(^2\).

   d. **To change the contact's password**, click the Change Password link and enter new password in the appropriate fields.

   e. **To change the custom attributes associated with contact (if any)**, enter values in the fields under the Custom Attributes section.

3. Click Submit.

### 6.6.5. Deleting a Contact

Select the check box corresponding to a contact and click Delete. You can delete a contact only if no entitlement exists for it.

---

\(^1\)Refers to the address where you want to receive your orders. It could be your home or office.

\(^2\)Refers to the address registered on your credit card. In simple words, it is the address where you receive the statements for your credit card. For your order to be approved when shopping online, the billing address provided by you has to match this address.
Managing Entitlements

The typical users assumed in this chapter are **Contract Operators** who are responsible for generating orders for the products offered by you. The major task done by contract operators is managing entitlements in Sentinel Cloud EMS.

Entitlement is also called Contract in Sentinel Cloud.

The following topics are addressed in this chapter:

7.1. What is an Entitlement? ................................................................. 66
7.2. Deployment Types ........................................................................ 66
7.3. Entitlement Types ......................................................................... 67
7.4. Lifecycle of an Entitlement .............................................................. 67
7.5. Creating an Entitlement ................................................................. 69
7.6. Reconfiguring an Entitlement ......................................................... 85
7.7. Viewing All Entitlements ................................................................. 88
7.8. Managing User IDs ........................................................................ 91
7.9. Changing Entitlement Status ......................................................... 91
7.10. Changing Line Item Status ........................................................... 92
7.11. Viewing Usage Data ...................................................................... 93
7.12. Viewing Billing Data ..................................................................... 93
7.13. Viewing Concurrent Session ......................................................... 94
7.14. Viewing Usage Count ................................................................... 95
7.15. Viewing License State ................................................................. 97
7.16. Duplicate Feature in Multiple Entitlements of a Customer - Deciding Consumption Order ... 98
7.1. What is an Entitlement?

After features and products have been defined in EMS by the product manager, the order generation staff can generate entitlements for the products. In simple words, entitlement generation means producing orders for the products. Entitlement provides your customers the right to use your product within the mutually agreed terms. The entitlements that are generated include the license models and attributes for the given products. The entitlements also contain information on the features of the product that the customer can use and their duration.

Each entitlement is identified by an unique entitlement ID (EID).

Read Next:

Deployment Types
Entitlement Types

7.2. Deployment Types

Deployment type specifies the environment where a protected application is installed. An entitlement can have one of the following deployment types:

- **Cloud**: Provisions entitlements for cloud licensing. Here, the protected application is externally hosted on a ISV-controlled server residing in Cloud.

- **On-premise**: Provisions entitlements for on-premise licensing. Here, the protected application is installed in a hostile environment within the customer’s premises. For On-premise Deployment Type, you also need to select a Feature Caching Mode that specifies how licenses are served and cached on an on-premise machine. Following options for Feature Caching Mode are available:
  
  - **Entitlement Level**: This type of on-premise licensing is meant for Server applications. The protected application is hosted on an on-premise server machine, which is accessed by multiple thin clients. All features of an entitlement are bought to an on-premise server machine, so this type of licensing is called Entitlement Level licensing. The maximum number of clients to which an entitlement can be served, is specified in Station Count field.

  The on-premise entitlements created with the **Entitlement Level** Feature Caching mode can also be consumed on machines that are never connected to the Internet. Such machines are called isolated machines.

  - **Feature Level**: This type of on-premise licensing is meant for client applications. The licenses are fetched directly from Cloud Connect for the requesting user. The licenses for only the requested features are bought to an on-premise client machine based on a user identity, so this type of licensing is called as Feature Level licensing.

To learn about entitlement types and license models available for a deployment type, refer to the diagram given in section *Understanding Relation between Deployment Type and Entitlement Type*
7.3. Entitlement Types

Cloud EMS supports creating two types of entitlements:

- **Retail**: These are the entitlements created for an individual. You need to specify User ID while creating a retail entitlement.
  
  All retail entitlements are **Named**, and are used by a single named user.

- **Enterprise**: These are the entitlements created for an organization. There are two types of enterprise entitlements:
  
  - **Named**: A user belonging to an enterprise can access the product (belonging to the entitlement) only if his name is mentioned in the entitlement. You need to specify number of users while creating a named entitlement. After the entitlement is created, you need to add the user IDs who are allowed to use the entitlement.
  
  - **Unnamed**: Infinite number of users from the enterprise can access the products (belonging to the entitlement). There is no need to add any specific user ID. All the users will have the same authorization rights.

**What is User ID?**

User ID is the identifier that helps to identify a user in case of named entitlements (both retail and enterprise). User ID is same as the identifier coming from the ISV application after authorizing a user of named entitlement.

User ID is defined and controlled by ISV. An ISV application authenticates this user ID and then pass it to cloud Run-time API for authorization.

### 7.3.1. Which Entitlement Types are Supported by Various Deployment Types?

<table>
<thead>
<tr>
<th>For deployment type..</th>
<th>Supported entitlement types are..</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud</td>
<td>All entitlement types are supported - Retail, Enterprise Named, and Enterprise Unnamed</td>
</tr>
<tr>
<td>On-premise with the Entitlement Level feature caching mode</td>
<td>Enterprise Named and Enterprise Unnamed</td>
</tr>
<tr>
<td>On-premise with the Feature Level feature caching mode</td>
<td>Enterprise Unnamed</td>
</tr>
</tbody>
</table>

7.4. Lifecycle of an Entitlement

There are three stages in the lifecycle of an entitlement. These are:
- **Draft**: When an entitlement is first created, it is saved in the Draft stage. You can modify entitlement details in this stage.

  Draft entitlements are represented by orange icons (橙) in the list.

- **Complete**: When you commit an entitlement, its stage is changed to Complete. Once an entitlement is committed, most of its attributes (such as service agreement, etc.) are fixed and cannot be changed. The entitlement in Complete stage gets deployed on server (Sentinel Cloud Connect).

  Complete entitlements are represented by green icons (绿) in the list.

- **Reconfigure**: To make changes to an entitlement that is in Complete stage, you need to change its stage to Reconfigure first. In the Reconfigure stage, you can change the terms of an entitlement. To re-deploy the entitlement, you need to commit the entitlement again.

  Reconfigured entitlements are represented by icons (红) in the list.

![Stages in the lifecycle of an entitlement](image-url)
7.5. Creating an Entitlement

This section explains how to create retail and enterprise entitlements. The typical steps involved in the creation of an entitlement are:

1. Entering basic details
2. Associating products to an entitlement
3. Configuring license model attributes of the features included in products
4. Configuring service agreement preferences
5. Committing an entitlement

Before you create an entitlement, ensure that the following information is available in the system:

- Customer Information - To add customer details, see Creating a Customer.
- Product Information - To add a product to a namespace, see Creating a Product.

7.5.1. Understanding Relation between Deployment Type and Entitlement Type

EMS allows you to create entitlements for different deployment types. The following diagram depicts which deployment type, entitlement type, and license model work with each other.
7.5.2. Entitlement Generation Workflows

This section contains flowcharts that provide a general idea of steps involved in creating cloud and on-premise entitlements.
Entitlement Generation for Cloud

Entering Basic Details (Cloud)

1. Enter/Edit Start/End Date
2. Enter Ref IDs
3. Select Deployment Type as Cloud
4. Enter Entitlement Type
5. Enter Customer
6. Select Contact
7. Enter Custom Attributes (if any)
8. Submit Entitlement
9. Create Contact (Enter new e-mail address)
10. Enter Customer exists?
11. Contact exists?
12. Enter User ID
13. Enter Enterprise
14. Enter Retail
15. No
16. Yes
17. Cancel or Create Customer
18. No
19. Yes
Creating Cloud Retail Entitlement

1. Entering Basic Details (Cloud)
2. Add Product
3. Enter Product Ref IDs
4. Turn On/Off Features
5. Select License Model
   - Subscription
   - Postpaid
   - Prepaid
   - Concurrent (Per Login/Per Identity)
6. Submit

Creating Cloud Enterprise Entitlement

1. Entering Basic Details (Cloud)
2. Entering Details (Named/Unnamed)
3. Add Product
4. Enter Product Ref IDs
5. Turn On/Off Features
6. Select License Model
   - Subscription
   - Postpaid
   - Prepaid
   - Concurrent (Per Login/Per Identity)
7. Submit
Entitlement Generation for On-premise

Entering Basic Details (On-premise)

1. Enter/Edit Start/End Date
2. Enter Ref IDs
3. Select Deployment Type as On-premise
4. Enterprise Unnamed Entitlement
5. Enter Customer
6. Customer exists?
   - Yes
   - Enter Custom Attributes (if any)
   - Submit Entitlement
   - Select Contact
   - Contact exists?
     - Yes
     - Create Contact (Enter new e-mail address)
     - No
     - Select Contact
     - Customer exists?
       - Yes
       - Create or Update Customer
       - No
6. Cancel or Create Customer
Creating On-premise Enterprise Unnamed Entitlement
7.5.3. Entering Basic Entitlement Details

The first step is to specify basic entitlement details, such as its start date, end date, deployment type; and the customer information for whom the entitlement is being created. At this initial step, you need to take two major decisions:

1. Do you want to create Cloud or On-premise entitlement?
2. Do you want to create Retail or Enterprise entitlement? For on-premise, you can create only Enterprise entitlements. For details, see Which Entitlement Types are Supported by Various Deployment Types?

Once you have decided about deployment type and entitlement type, you will proceed to the next step of adding product details.

To create an entitlement:

1. On the main menu, click Entitlements. The Entitlements page appears.
2. Click New on the right side of the page. The New Entitlement pop-up appears.
3. Enter a start date for the entitlement in the **Start Date** field.

4. Enter an end date for the entitlement in the **End Date** field. The end date should be greater than or equal to the start date.

   To extend the life of the entitlement infinitely, select **Never Expires**.

5. Enter **RefID 1** and **RefID 2** if required.

6. Specify the **Deployment Type** from one of the following:

   - **Cloud**: Select if you want to deploy the entitlements for cloud licensing. The Cloud deployment type supports both Retail and Enterprise entitlements.
     - If you want to create a retail entitlement:
       a. Select **Retail**.
       b. In the **UserID** field, enter the user ID of an individual accessing the product.
     - If you want to create an enterprise entitlement, select **Enterprise**.
   - **On-Premise**: Select if you want to deploy the application for on-premise licensing. The On-premise deployment type supports Enterprise entitlements only. For details, see [Which Entitlement Types are Supported by Various Deployment Types?](#).

An entitlement can be created either for cloud or for on-premise. After an entitlement has been created, you cannot edit the deployment type from cloud to on-premise, or vice versa. You will need to delete the existing entitlement and create a new one with the required deployment type.

7. Associate a **customer** and a **contact** with the entitlement, as described below:

   a. Type the first few characters of the customer name in the **Customer Name** auto-complete field.
b. Select a name from the list of matching names that appear. A pop up window is displayed that shows reference ID of the customer. In the case of duplicate customer names, select the record with the desired reference ID, and click OK.

- **To select an existing contact of the customer**
  a. The contact e-mail IDs associated with the selected customer are displayed in the Contact E-mail drop-down list.
  b. Select a contact from the Contact E-mail drop-down list.

- **To create a new contact for the customer**
  a. Select the Create New Contact check box.
  b. Enter the e-mail address of the contact in the field that follows.

| The EMS login of the new contact, created on the Entitlements screen, is disabled by default. |
| The contact associated with an entitlement acts as the customer's administrator, and can perform all the tasks defined [here](#). |
| By default, the new contact is added as the secondary contact for the customer. |
| After an entitlement has been created, you (or the primary contact) can perform various contact management tasks, such as create and associate a new contact. |
| The time zone of the selected customer gets displayed, based on which the licenses are served to the customer. |

Please note that once an entitlement has been created for a customer, you cannot change the time zone. We recommend to verify the time zone while creating first entitlement for a customer and change it if required. You can change the customer time zone from the Edit Customer screen.

8. If any custom attributes are available for the entitlement entity, the Custom Attributes section appears towards the end of the pop-up. Specify the custom attributes values, as required.

9. Click Submit.

With this, the entitlement gets created and is saved as Draft. The next step is to add line items to the entitlement. The newly created entitlement appears at the top of the entitlements list and its details appear on the right-hand side of the page.

You may proceed further to commit the entitlement or you may choose to do it later.
7.5.4. Adding Products to an Entitlement

After an entitlement has been created (and its lifecycle stage is Draft), you can add products to the entitlement one by one. To add a product:

The Steps 1 to 3 are applicable only for an existing entitlement, which is in Draft stage.

1. On the main menu, click Entitlements and select the entitlement to which you want to add products from the list in the left pane.
2. Click to expand the Associated Product and Features pane on the right.
3. Click Add Product. The Add product pop-up is displayed.
4. If you have selected On-premise Deployment Type, the Feature Caching Mode section is displayed. It specifies how licenses are served for on-premise consumption. From the Mode drop-down, select one of the following:

   - **Entitlement Level**: Select this option to create on-premise entitlements meant for server deployment. All the features of an entitlement will be made available to a user for consumption.

   - **Feature Level**: Select this option to create on-premise entitlements meant for client deployment. Only the requested features will be made available to a user for consumption.
On-premise Entitlement Level

![Add Product Form](image)

- **Feature Caching Mode**
  - Mode: Entitlement Level
  - Detach Interval (hrs): 2160
  - Station Count: 1
  - Collect Usage: ✔
  - VM Enabled: ✔
  - Clone Protection: ☐

- **Product Details**
  - Type: Named
  - RefID 1:
  - RefID 2:

- **Select Product**
  - Search: Product Name
  - Total Records: 10
  - Page (1 of 4) < < < > >>
  - Name: DemoProductOne
  - Version: 1.0
  - Namespace: DemoNamespace

- **Feature List and Associated License Models**
  - Enforcement: Sentinel Cloud Ver 3.6.0
  - Feature: DemoFeatureOne
  - License Model: Postpaid

- **Buttons:** Submit, Close
Chapter 7: Managing Entitlements

On-premise Feature Level

5. If you have selected **Entitlement Level**, provide the following information:

   a. In the **Detach Interval** field, specify the number of hours for which the entitlement can be detached. Select **No Limit** if you want to allow the entitlement to be detached for an indefinite duration.

      The default and maximum allowed value of this parameter are configurable and can be changed from Admin Console.

   b. In the **Station Count** field, specify maximum number of on-premise server machines on which an entitlement can be detached. The minimum value allowed is 1. The default maximum value is 50.

      The default maximum value of station count is configurable and you can get it increased up to 999999 by contacting SafeNet Support (if required).
c. Select or clear the **Collect Usage** check box to enable or disable the usage data collection for on-premise machines. This option is selected by default.

d. Select or clear the **VM Enabled** check box to specify whether or not a protected application should run in virtualized environment. The default value of check box is controlled from [Admin Console](#). Selecting it creates VM-enabled entitlements whose licenses can be consumed on virtual machines. In this case, a virtual machine is treated as a separate machine and adds to a station count.

e. Select or clear the **Clone Protection** check box to enable or disable protection against virtual machine cloning. A clone is a copy of an existing virtual machine. Running applications on a cloned virtual machine can lead to misuse of software licenses. When Clone Protection is enabled, the protected application is not allowed to run on a machine that has been detected as a clone.

The value of Clone Protection is dependent on the VM Enabled check box. If VM Enabled is on, you can switch on/off Clone Protection. If VM Enabled is off, then Clone Protection is disabled. The default value of the Clone Protection check box is controlled from [Admin Console](#).

6. If you have selected **Feature Level**, provide the following information:

a. In the **Detach Interval** field, specify the number of hours for which the features can be detached.

The default and maximum allowed value of this parameter are configurable and can be changed from [Admin Console](#).

b. In the **Cache Interval** field, specify the maximum duration for which the license is cached locally by an on-premise machine. The default value is 60 minutes. You can enter a value in the range of 1-43200 minutes (30 days).

VM Enabled and Clone Protection are always ON for Feature Level Entitlements

In the current release, VM Enabled and Clone Protections options always remain ON for feature level entitlements. This means that licenses are allowed to be consumed on a virtual machine. A virtual machine is treated as a separate machine and adds to a station count. Also, the protected application is not allowed to run if the underlying machine is detected as a clone.

7. In the case of enterprise entitlements, the **Product Details** pane shows entitlement types (Named, Unnamed) and Ref Ids.

For Cloud Entitlements and On-premise Entitlements Created with "Entitlement Level"

**Feature Caching Mode**

- To create an Enterprise Unnamed entitlement, select **Unnamed** (if not already
selected).

- To create an Enterprise Named entitlement, follow the steps given below:
  
  a. Select Named.
  
  b. In the #Users field that appears, enter the number of users entitled to use the products included in the entitlement. You can add user IDs to a named entitlement later, as described in Managing User IDs.

**Notes:**

- All the products inside an entitlement are of only one type - either named or unnamed.

- If you want to change the entitlement type from unnamed to named (for draft entitlements) later, then edit the existing line items and specify the Named type. You will need to add the number of users at the same time.

- If you want to change entitlement type from named to unnamed (for draft entitlements) later, then edit the existing line item and select the Unnamed type.

**For On-premise Entitlements Created with "Feature Level" Feature Caching Mode**

- Only the Unnamed option is available in this case, because currently only the Enterprise Unnamed entitlements are supported by the Feature Level Feature Caching Mode.

8. Enter the values of RefID 1 and RefID 2, if required. You can enter information that identifies the product in your company's ERP system.

9. **Select Product** - Select a product from the Select Product pane.

   The expandable pane displays all the products available in your EMS workspace. To streamline the list, you can also search the product(s).

   **For on-premise applications, you can select only those products that contain features with on-premise supported license models.**

10. **Finalize features and license models** - When you select a product, the Features List and Associated License Models pane expands, displaying all the features available in the selected product.

    a. The Switch On check box is enabled for the optional features, if any in the selected product. Select/Clear the check box to include/exclude a feature. At least one feature must be included.

    b. Change the license models associated with the features as required by using the License Model drop-down list.
For on-premise entitlements:

- If a feature is associated with a license model not supported in on-premise, the license model is disabled and the other license model that is supported gets selected automatically.
- See the Table, "Supported License Models" to view list of license models that are supported for on-premise.

11. Click Submit. The product is added and its details are displayed on the Entitlements screen in the Associated Product and Features pane.

Similarly, you can add more products to a draft entitlement.

### 7.5.5. Configuring License Model Attributes for the Features

You can configure (or edit) the license model attributes associated with the feature when the entitlement is in Draft stage. To change the license model attributes, follow the steps below:

1. On the main menu, click Entitlements.
2. From the left pane, select the entitlement for which you want to change the license model attributes.
3. Click to expand the Associated Product and Features pane on the right.
4. Select the product for which you want to change the license attributes.
5. Click to expand the List of features associated pane, and do one of the following:

   - To modify attributes of an individual feature:
     - Click the Feature-wise link, and then the Configure License Model link corresponding to the feature you want to modify.

   - To simultaneously modify attribute values for all the features having same license model:
     - Click the Group By License Models link, and then the Configure License Model link corresponding to the license model.

The Configure License Model pop-up appears, showing the license model attributes. The attribute groups (for example, Time and Usage Type) vary depending on the license model.

6. Expand the attribute group, and modify the attribute values as required.

   You can configure values of only the overridable attributes of a license model.

   In the case of on-premise entitlements, the Concurrent license model does not support Per Identity counting type.
The start date and end date are inherited from the associated license model type. To provide different dates or time for license attributes, enter values in the Start Date and End Date fields.

Ensure that the end date specified here does not exceed the entitlement end date.

6. Click Save.

7.5.6. Configuring Service Agreement Preferences

You can change the service agreement attributes, specifically the aggregation frequency, associated with a product only if the entitlement is in Draft stage. To change the service agreement preferences, follow the steps below:

1. On the main menu, click Entitlements.
2. From the left pane, select the entitlement for which you want to configure the service agreement preferences.
3. Click to expand the Associated Product and Features pane on the right.
4. Select the product for which you want to change the service agreement attribute values.
5. Click to expand the Product Details pane, and click the Configure Service Agreement link. The Configure Service Agreement pop-up appears.
6. Click to expand the Preferences group, and modify the values of aggregation frequency.
7. Click Submit.

You can configure value of aggregation frequency only if it is set to overridable in the service agreement associated with the entitlement. (While creating a service agreement, an attribute can be set to overridable, to allow changing the attribute value at the time of entitlement creation).

7.5.7. Committing an Entitlement

At least one product must be added to an entitlement before committing the entitlement. Once you are sure that the products associated with the entitlement are final, you can commit the entitlement. The entitlement is deployed at Sentinel Cloud Connect. An e-mail is sent to the designated recipients (ISV, customer, or both) as configured in Admin Console. After committing, the lifecycle stage of the entitlement changes to Complete.

- The e-mails are sent only if the E-mail Required field is set to Desired in the Admin.
The e-mails are also sent to an alternate e-mail address, if any, associated to an entitlement by using EMS Web services.

To commit an entitlement, select the entitlement from the left pane and click **Commit**.

To view the entitlement certificate, click **View Certificate** (see Viewing Entitlement Certificate).

### 7.6. Reconfiguring an Entitlement

The Reconfigure feature provided in EMS enables you to modify attributes of a committed entitlement, which has been deployed at server. When an entitlement is reconfigured, its **stage** is changed from Complete to Reconfigure. After completing the changes, you need to commit the entitlement again to re-deploy it on the server.

Following table lists what you can and cannot modify for a reconfigured entitlement.

<table>
<thead>
<tr>
<th>What you can modify?</th>
<th>What you cannot modify?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Following license model attributes:</td>
<td>Following license model attributes:</td>
</tr>
<tr>
<td>- Start date and end date</td>
<td>- Usage Type</td>
</tr>
<tr>
<td>- Concurrent limit and Instance counting (for features having concurrent license model)</td>
<td>- Non-overridable attributes</td>
</tr>
<tr>
<td>- Maximum usage count (for features having prepaid license model)</td>
<td>- Service agreement attributes.</td>
</tr>
<tr>
<td>- Grace Limit and Measurement Unit</td>
<td>- You cannot add a product, revoked earlier from the entitlement, to a reconfigured entitlement.</td>
</tr>
<tr>
<td>- Vendor Attribute</td>
<td>- You cannot change the entitlement type:</td>
</tr>
<tr>
<td>- Capacity Attribute</td>
<td>- Retail to enterprise, or vice versa</td>
</tr>
<tr>
<td>You can reconfigure only the <strong>overridable</strong> license attributes. For details of attributes, see License Attributes.</td>
<td>- Named to Unnamed, or vice versa</td>
</tr>
<tr>
<td>Number of users defined for an enterprise named entitlement.</td>
<td>You cannot change the deployment type.</td>
</tr>
</tbody>
</table>

The change applies to all the products within entitlement.

The following conditions apply:

- You can increase the number of users.
<table>
<thead>
<tr>
<th>What you can modify?</th>
<th>What you cannot modify?</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ You can decrease the number of users to a value not lesser than the count of currently provisioned users. For example, if the number of users is 5 and you have already added 3 user IDs, then you can decrease the value down to 3 (not lesser than that).</td>
<td></td>
</tr>
<tr>
<td>■ Products associated to an entitlement</td>
<td></td>
</tr>
<tr>
<td>■ You can add/edit products.</td>
<td></td>
</tr>
<tr>
<td>■ You can switch on/off the features in the product.</td>
<td></td>
</tr>
<tr>
<td>■ Custom attributes values, if any</td>
<td></td>
</tr>
<tr>
<td>■ Detach Interval (applicable only for on-premise entitlements).</td>
<td></td>
</tr>
<tr>
<td>■ Station Count (applicable only for on-premise entitlements created with Entitlement Level caching mode).</td>
<td></td>
</tr>
<tr>
<td>The change applies to all the products within entitlement.</td>
<td></td>
</tr>
<tr>
<td>■ Collect Usage (applicable only for on-premise entitlements created with Entitlement Level mode)</td>
<td></td>
</tr>
<tr>
<td>■ VM Enabled (applicable only for on-premise entitlements created with Entitlement Level mode)</td>
<td></td>
</tr>
<tr>
<td>■ Clone Protection (applicable only for on-premise entitlements created with Entitlement Level mode)</td>
<td></td>
</tr>
<tr>
<td>■ Cache Interval (applicable only for on-premise entitlements created with Feature Level mode).</td>
<td></td>
</tr>
</tbody>
</table>

**Steps to Reconfigure An Entitlement**

The steps to reconfigure an entitlement are:

1. On the main menu, click **Entitlements**.
2. From the left pane, select the committed entitlement that you want to reconfigure.
3. In the **Entitlement Details** pane on the right, click 

   The entitlement is reconfigured. The entitlement's stage is changed from Complete to Reconfigure.
Reconfiguring License Attributes

1. Expand Associated Product and Features and select a product.

2. Expand List of features associated, and do one of the following:
   - To modify attributes of an individual feature:
     Click the Feature-wise link, and then the Configure License Model link corresponding to the feature you want to modify.
   - To simultaneously modify attribute values for all the features having same license model:
     Click the Group By License Models link, and then the Configure License Model link corresponding to the license model.

3. Reconfigure attributes as required. Refer to the table above for the list of modifiable attributes.

Reconfiguring Number of Users for Enterprise Named Entitlement

1. Click Edit in the Associated Product and Features pane.

2. Change the number of users in the Edit Product dialog box. See the table above for the terms of change.

3. Click Submit.

Adding Product

Click Add Product in the Associated Product and Features pane to add products to an entitlement.

All the products inside an entitlement can be of only one type, either named or unnamed.

Including/Excluding Feature

1. Click Edit in the Associated Product and Features pane.

2. The Switch On check box is enabled for the optional features, if any in the selected product. Select/clear the check box to include/exclude a feature. At least one feature must be included.

Reconfiguring Station Count of an On-premise Entitlement Level Mode

For on-premise entitlement created with entitlement level feature caching mode, you can reconfigure the number of machines on which an entitlement can be used or detached.

1. Click Edit in the Associated Product and Features pane. The Edit Product dialog box is displayed.

2. Under the Feature Caching Mode section, change the value of Station Count. The minimum value allowed is 1. The maximum value allowed is 50 by default, but you can get it increased up to 999999 by contacting SafeNet Support (if required).

3. Click Submit.
7.7. Viewing All Entitlements

Click Entitlements. The Entitlements page appears showing entitlement IDs and their details in the left pane.

This is a read-only page. However, options are available in this page to search/delete/view an entitlement and view the entitlement certificate.

### 7.7.1. Searching Entitlements

1. In the left pane, select a search criteria from the Search drop-down list.
2. Enter a value for the search in the second field.
3. Click . The entitlements matching the search parameter are displayed. The list shows entitlements for which status is either Enabled or Disabled.

**Viewing Revoked Entitlements**

By default, the entitlement list shows entitlements for which status is either Enabled or Disabled; the Revoked entitlements are not displayed. You can view revoked entitlements by using any of the following methods:

- Click Show All.
- While performing basic search, select search criteria as By Status and value as Revoked.
- Click Advanced Search, select Revoked from the Status drop-down list, and click Search.

If you perform advanced search for a specific EID, ensure that the exact status of the EID is selected in the Status field.

### 7.7.2. Viewing Details of an Entitlement

Select an entitlement from the left pane to view its details.
7.7.3. Deleting an Entitlement

You can delete an entitlement only if its lifecycle stage is Draft. To delete an entitlement, select it from left and click **Delete** in the right pane.

7.7.4. Viewing Entitlement Certificate

The entitlement certificate contains the details of the entitlement. To view the entitlement certificate for a committed entitlement:

1. Select a committed entitlement from the left pane.
2. Click **View Certificate**. The entitlement certificate appears that shows entitlement and product details. For on-premise entitlements, the certificate displays additional information, such as Deployment Type and Feature Caching Mode.

**Entitlement certificate for Cloud Entitlements**

<table>
<thead>
<tr>
<th>Entitlement Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>EID: e11033-o17514524-d3a.33077767-1e1f3</td>
</tr>
<tr>
<td>Start Date: 05/23/2012</td>
</tr>
<tr>
<td>RefID 1:</td>
</tr>
<tr>
<td>Contact Email: <a href="mailto:Customer1@gmail.com">Customer1@gmail.com</a></td>
</tr>
<tr>
<td>Customer Ref ID: Customer1</td>
</tr>
<tr>
<td>Customer Time Zone: (GMT) Greenwich Mean Time, : Dublin, Edinburgh, Lisbon, London</td>
</tr>
<tr>
<td>Deployment Type: Cloud</td>
</tr>
</tbody>
</table>

**List of Products**

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Product</th>
<th>Status</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>P1.2.1</td>
<td>Enabled</td>
<td>UnNamed</td>
</tr>
</tbody>
</table>

**Entitlement certificate for On-premise Entitlements deployed with Entitlement Level Caching Mode**
Entitlement certificate for On-premise Entitlements deployed with Feature Level Caching Mode

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Product</th>
<th>Version</th>
<th>Status</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>P1</td>
<td>1</td>
<td>Enabled</td>
<td>Named</td>
</tr>
</tbody>
</table>
Forwarding Entitlement Certificate

If you want to forward the entitlement certificate, click the **Email** button on the Entitlement Certificate screen, specify the desired e-mail address in the dialog box that appears, and click **Send**.

The e-mail is forwarded only if the **E-mail Required from View Certificate** field is set to **Desired** in the **Admin Console**.

7.8. Managing User IDs

In case of enterprise named entitlements, user IDs need to be mapped to the entitlement. This section describes how to add/delete user IDs to/from an enterprise named entitlement.

**Important**

Please note that user IDs are managed at the entitlement level. It means a user ID mapped to an entitlement has access to all the products and features belonging to the entitlement.

7.8.1. Adding User IDs to Enterprise Named Entitlements

To add user ID to a named entitlement:

1. On the main menu, click **Entitlements > Entitlements**. The Entitlements page appears. The left pane displays entitlement IDs and their details.
2. Search the enterprise named entitlement for which you want to add user IDs.
3. In the **Entitlement Details** pane, click 📧. The **Manage User IDs** dialog box is displayed.
4. In the **UserID** text box, type the User ID and click **Add**. Repeat this step to add multiple User IDs.
5. Click **Save**.

7.8.2. Deleting User IDs from the Enterprise Named Entitlements

To delete a user ID from a named entitlement:

1. On the main menu, click **Show All Entitlements**.
2. Search the enterprise named entitlement for which you want to delete user IDs.
3. In the **Entitlement Details** pane, click 📧. The **Manage User IDs** dialog box is displayed.
4. Select the check box(es) corresponding to User ID(s) you want to delete. Click **Delete**.

7.9. Changing Entitlement Status

A committed entitlement can have one of the following three statuses:
**Enabled**: Indicates that the entitlement is active. The customer can request/consume an entitlement only if it is enabled.

**Disabled**: Indicates that the entitlement is inactive temporarily (for reasons, such as non-payment). The customer cannot consume an entitlement if it is disabled.

**Revoked**: Indicates that the entitlement has been made inactive permanently (for reasons, such as entitlement expired and not continued by customer). The customer cannot consume an entitlement if it is revoked.

By default, the status of a committed entitlement is Enabled.

**Important**

The status of an entitlement applies to all the products and features belonging to the entitlement. If you want to change the status of associated product (called line item), see Changing Line Item Status.

To change the entitlement status:

1. On the main menu, click **Entitlements**.
2. Select the entitlement to which you want to add products from the list.
3. Next to the **Entitlement Details** pane on the right, click 

   The **Change Entitlement Status** pop-up appears.

   ![The button is not available if the entitlement status is Revoked.]

4. Change the status, as required.
5. Click **Save**.

**7.10. Changing Line Item Status**

A product that is associated to an entitlement is called line item. A line item can have one the following status:

- **Enabled**: Indicates that the line item is available for use by the customer.
- **Disabled**: Indicates that the line item is not available.
- **Revoked**: Indicates that the line item has been made inactive permanently. Once set to Revoked, the status of a line item cannot be changed.

By default, the status of a line item is **Enabled**.

To change the line item status:

1. On the main menu, click **Entitlements**.
2. Select the entitlement to which you want to add products from the list.
3. Next to the **Product Details** pane on the right, click 

The **Change Product Status** pop-up appears.

   The button is not available if the entitlement status is **Revoked**.

4. Change the status, as required.

5. Click **Save**.

### 7.11. Viewing Usage Data

EMS allows you to track the usage history of a customer for data analysis and billing purposes.

You can view usage of an entitlement only if it has been aggregated by Data Engine.

The steps to view details of consumed products are given below.

1. On the main menu, click **Entitlements**.
2. In the left pane, select the entitlement to which the product belongs.
3. On the right side, expand **Associated Product and Features**, and select the product for which you want to view usage data.

   Details of the selected product are displayed in the **Product Details** pane

4. Click the **View Usage Data** icon. The **View Usage Data** dialog box is displayed.
5. Select dates in the **From** and **To** fields to specify the duration for which you want to view the usage data.
6. Click **Submit**.

   Details, such as feature name, start/end dates, usage count, and usage time are displayed for the selected product.

### 7.12. Viewing Billing Data

You can also view the billing data for all the products included in an entitlement. Different type of billing details that you can view are:

- **Itemized Billing**: A descriptive bill that provides consumption details for a product on per feature per customer basis.
- **Detailed Billing**: It is less descriptive than the itemized bill and provides consumption details per feature.
- **Brief Billing**: It provides a brief summary of the products consumed within a specified period.

This data is partially processed data that can be used as the basis of generating bills, but is not the actual bill. This will need processing before it can be used for billing purposes.
The steps to view billing data are:

1. On the main menu, click **Entitlements**.
2. In the left pane, select the entitlement to which the product belongs.
3. On the right side, expand **Associated Product and Features**, and select the product for which you want to view billing data.
   
   Details of the selected product are displayed in the **Product Details** pane.
4. Click the Billing Data icon. The **Billing Data** dialog box is displayed.

![Billing Data Dialog Box](image)

5. Select dates in the **From** and **To** fields to specify the duration for which you want to view the billing data.
6. From the drop-down list, select the type of bill you want to view.
7. Click **View**. Billing details are generated in the excel format.

### 7.13. Viewing Concurrent Session

EMS allows you to view concurrent sessions established to a feature by one or more user.

For on-premise feature level applications, you can view the type of on-premise licenses served, Detached or Connected. For Detached licenses, the maximum duration for which the license can remain disconnected is also shown.

- This is applicable to only the features having concurrent license model.
- The page displays all concurrent login sessions established to a feature by one or more user (regardless of how the concurrent instances are counted).
- You cannot view concurrent sessions for on-premise entitlement level applications.

**Steps for Product Manager**
1. On the main menu, click **Entitlements**.

2. From the left pane, select the required committed entitlement.

3. Click to expand the **Associated Product and Features** pane on the right.

4. Select the product with at least one feature having the concurrent license model associated to it.

5. Click the View Current Session icon, ![View Current Session icon].

   The **View Current Session** page is displayed, showing details of concurrent sessions. Details include user name, feature name, login time, etc.

6. You can use **Remove Sessions** to clear a user session details from Sentinel Cloud Connect, if a run-time logout call for the session does not complete successfully. Please note that it does not kill the actual session from run-time. It is suggested to use this feature sparingly.

**Steps for a customer who has logged in to EMS using EID**

1. On the **Entitlements** page, click to expand the **Associated Product and Features** pane.

2. Select the product with at least one feature having the concurrent license model associated to it.

3. Click the View Current Session icon, ![View Current Session icon].

   The **View Current Session** page is displayed, showing details of concurrent sessions.

**Steps for a customer who has logged in to EMS using user ID and password**

1. On the **Entitlements** page, search and select the required entitlement in the left pane.

2. Click to expand the **Associated Product and Features** pane on the right.

3. Select the product with at least one feature having the concurrent license model associated to it.

4. Click the View Current Session icon, ![View Current Session icon].

   The **View Current Session** page is displayed, showing details of concurrent sessions.

### 7.14. Viewing Usage Count

For committed entitlements, you can view usage count of features having prepaid license model.
Steps for Product Manager

1. On the Entitlements page, select a committed entitlement from the left pane.
2. Click to expand the Associated Product and Features pane on the right.
3. Select the product with at least one feature having the prepaid license model associated to it.
4. In the Product Details pane, click the View Current Usage Count icon, ![icon].
   The View Current Usage Count page is displayed, showing the usage count and the total count of the feature.

Steps for a customer who has logged in to EMS using EID

1. Click to expand the Associated Product and Features pane.
2. Select the product with at least one feature having the prepaid license model associated to it.
3. In the Product Details pane, click the View Current Usage Count icon, ![icon].
   The View Current Usage Count page is displayed, showing the usage count and the total count of the feature.

Steps for a customer who has logged in to EMS using user ID and password

1. On the Entitlements page, search and select a committed entitlement from the left pane.
2. Click to expand the Associated Product and Features pane on the right.
3. Select the product with at least one feature having the prepaid license model associated to it.
4. In the Product Details pane, click the View Current Usage Count icon, ![icon].
   The View Current Usage Count page is displayed, showing the usage count and the total count of the feature.
7.15. Viewing License State

Every feature has a license associated with it, which can have one of the following states:

- **Not Active**: Indicates that the feature has not been used yet. This is the default state of license. When a product is deployed, the license state for all its features is Not Active.
  
  Also, when an entitlement is reconfigured, its state is reset to Non Active.

- **Active**: Indicates that the features is in use. When a feature is used for the first time, its license state is changed from Not Active to Active.

- **Expired**: Indicates that the feature cannot be used because it has reached its end date.

- **Exhausted**: Indicates that the feature cannot be used because it has already been used for the maximum number of times allowed.

- **Grace**: This state is reached after the Expired/Exhausted state. It indicates that the license has expired/exhausted and the feature is running in the grace state.

The Grace state is visible to you but not to your customer. The customer views the state as Exhausted/Expired.

The license state for a feature is maintained on the Sentinel Cloud Connect database.

EMS allows you to view the current license state of a feature, using the steps given below.

**Steps for Product Manager**

1. On the Entitlements page, select the committed entitlement in the left pane.
2. On the right side, expand Associated Product and Features, and select a product.
3. Expand List of features associated, and click the Feature wise link. List of all the features associated with the product is displayed.
4. Click on under the License State column for the feature, state of which you want to view. The license state retrieved from the Sentinel Cloud Connect database is displayed.

**Steps for a customer who has logged in to EMS using EID**

1. On the Entitlements page, expand Associated Product and Features, and select a product.
2. Expand List of features associated, and click the Feature wise link. List of all the features associated with the product is displayed.
3. Click on under the License State column for the feature, state of which you want to view. The license state retrieved from the Sentinel Cloud Connect database is displayed.

**Steps for a customer who has logged in to EMS using user ID and password**

1. On the Entitlements page, search and select the required entitlement in the left pane.
2. On the right side, expand Associated Product and Features, and select a product.
3. Expand List of features associated, and click the Feature wise link. List of all the features associated with the product is displayed.

4. Click + under the License State column for the feature, state of which you want to view. The license state retrieved from the Sentinel Cloud Connect database is displayed.

### 7.16. Duplicate Feature in Multiple Entitlements of a Customer - Deciding Consumption Order

There can be packaging scenarios where a same feature exists in multiple entitlements created for a customer. In such scenarios, an entitlement is retrieved for feature consumption based on the following criteria (in the order of decreasing priority):

1. The entitlements are first sorted based on their statuses.
2. If entitlement status is same and entitlement is of type on-premise feature level, then the feature whose license end date is nearest to the requested detach interval is considered for sorting. (see Example 2)
3. Next, sorting is done based on the state of the duplicate feature.
4. If feature state is same, the feature in the Grace state gets the priority. Note that for a feature in Grace, the state is either Expired or Exhausted.
5. Next level of priority is the entitlement type - named or unnamed. Note that if a user is associated with two entitlements, named and unnamed, the named entitlement has higher priority. If another user is not assigned in named entitlement, then the unnamed entitlement has higher priority.
6. At last, the feature is picked for consumption from the new entitlement.

#### 7.16.1. Example 1

Suppose we have two enterprise entitlements for a customer, E1 and E2. Here:

- E1 is a named entitlement with two named users U1 and U2.
- E2 is an unnamed entitlement.

The same product P1 is included in both entitlements. P1 contains the following three features:
- F1 associated with Post-paid license model
- F2 associated with Pre-paid license model
F3 associated with Subscription license model

Creation Order: E1 is created before E2.

**Case 1: E2 is disabled, E1 is enabled.**

If user U1 requests for F1, the feature will be served from E1 though E2 was created last. This is because the priority of the enabled status is higher than the disabled status.

**Case 2: E1 and E2 are enabled, features are in active state in E1 and features are in not active state in E2. The assumption is that E2 is created because E1 is going to expire in near future.**

If user U1 requests for F1, the feature will be served from E1 though E2 was created last since active state has higher priority over not active state.

**Case 3: E1 and E2 are enabled, feature F1 is expired in both E1 and E2, and is in grace period in E2.**

If user U1 requests for F1, in this case it will be served from E2 because with both features in same state, the feature with grace period has higher priority over feature with no grace.

Note that for a feature in grace, the state is either Expired or Exhausted.

**Case 4: E1 and E2 are enabled, and features are in active state in both entitlements.**

If user U1 requests for F1, in this case it will be served from E1 though E2 was created last. If states are same, then feature in named entitlement has higher priority over feature in unnamed entitlement if the requested user exists in the named entitlement.

**Case 5: E1 and E2 are enabled, and features are in active state in both entitlements.**

If user U5 requests for F1, it will be served from E2. Since E2 was created last and if states are same, then feature created last has higher priority. Also note that U5 does not exist in E1, so unnamed feature has higher priority here over named. So creation date is not considered. If everything matches then last entitlement is picked according to creation date because entitlement created last has higher priority.

**7.16.2. Example 2**

Suppose we have an on-premise entitlement with Feature Level feature caching mode. If a feature F1 is requested for 10 days and there are 3 entitlements of that customer containing F1 feature with license end dates 11 days, 8 days, and 12 days respectively. In this case, the license will be served from the first entitlement.
Managing Custom Attributes

This chapter is meant for the users having administrative privileges.

The custom attributes provide the ability to store custom data for EMS entities. By using custom attributes, you can create placeholders to store additional information for an EMS entity. You can create custom attributes for the following entities:

- Feature
- Product
- Customer
- Contact
- Entitlement

The custom attributes defined for an entity become part of each instance of that entity, irrespective of its lifecycle stage. You can assign a default value to each custom attribute. The user can change these default values and assign new values to the attributes while creating an instance of an entity.

For example, you may need to save the company Web site address for each contact you create. For this, you can create a custom attribute Company Web site, of the template type Contact. Afterwards, you can save the company Web site address for each contact in the new attribute.

The custom attributes are not used in license enforcement. Also, details of custom attributes are stored in EMS database only, and are not sent to Cloud Connect.

8.1. Creating a Custom Attribute

1. On the main menu, click Configure > Template.
2. Click New. The Add Attribute pop-up appears.
3. From the Template drop-down list, select the EMS Entity for which you want to define custom attribute.

4. In the Attribute Name field, enter a name for the attribute. You can enter alphanumeric characters.

5. From the Data Type drop-down list, specify the data type of custom attribute. The available options are: String, Date, Boolean, and Integer.

6. (Optional) Specify the Default Value. You can enter alphanumeric characters.

7. (Optional) Add a description in the Description field. You can enter alphanumeric characters.

8. (Optional) To make the attribute mandatory, clear the Optional check box.

9. (Optional) Provide a Regular Expression that you want to use for validating the input value of custom attribute. For example, the following regular expression validates an e-mail address value.

```
^([a-zA-Z0-9\x00-\x0F\x20-\x7F]+)@(\((\[[0-9]{1,3}\.]\.[0-9]{1,3}\.]\[[0-9]{1,3}\]\)\|[\[a-zA-Z0-9\x00-\x0F\x20-\x7F]\]2,4][0-9]{1,3})\dux$```

10. Click Submit.

### 8.2. Viewing All Custom Attributes

1. On the main menu, click Configure > Template. The template attributes are listed in the left pane.

2. Select any attribute in the left pane to view its details.
8.3. Editing the Details of a Custom Attribute

1. Select an attribute from the left pane.
2. Click Edit on the right side of the page. The Edit Attribute pop-up appears. In this page, you can edit the following:
   - Attribute Name
   - Default Value
   - Description
   - Regular Expression
   - Optional/mandatory status of the attribute
3. Click Submit.

8.4. Deleting a Custom Attribute

You can delete a custom attribute if it is not used in any entity. To delete an attribute:

1. Select an attribute from the left pane.
2. Click Delete on the right side of the page.

8.5. Assigning Values to the Custom Attributes in an Entity

After you have defined the custom attributes for an entity, the attributes get associated with all the existing entities of similar type. For example, if you have defined an attribute 'Web site' for the entity 'Contact', the attribute will be available to all the Contacts that have already been defined.

When you create a new entity by clicking the New button, an additional section Custom Attributes appears at the end of the popup that is displayed. This section contains the custom attributes defined for the entity, wherein you need to specify the attributes values.
EMS provides you with the ability to produce reports with valuable business information, based on data in the EMS database. With this, managers can obtain data for analyzing how their software is used and the purchasing preferences of their customers. The information can also be leveraged to maximize revenues from license renewals, to up-sell existing customers, and turn trial users into buyers.

This chapter provides an overview of the features and options available in the Reports functionality. EMS reports provide access to selected current information from the EMS database. Different predefined reports are available to meet various requirements. The reports provide information in tabular form and, where applicable, in a graphical chart.

The Reports functionality can be accessed using the Reports tab in the main menu. On clicking Reports, a list of the available reports is displayed in the left pane, organized by category. This window enables you to specify parameters for a report and generate one for immediate viewing in the format specified. You can print the output file or save it for later use. The output format can be one of the following:

- Rich Text Format (RTF)
- Adobe Acrobat (PDF)
- HTML
- Microsoft Excel (XLS)

This section includes the following:

9.1. Generating a Report ................................................................. 105
9.2. Available Predefined Reports .................................................. 106

9.1. Generating a Report

To generate a report:

1. Click the Reports menu.
2. In the left pane of the screen that appears, click the report you want to generate.
3. In the right pane, enter the input parameters.
4. Select the output type from the **Output Format** drop-down list.

5. Click **Generate Report**.

The report is generated in the output format specified. You can print the report or save it for future use.

### 9.2. Available Predefined Reports

The following table describes the various reports available in EMS:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Input Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entitlement Reports</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Customer Entitlement Report        | Lists all the entitlements generated and summarizes them by customer and date. | - **Entitlement Start Date**: It is the entitlement Start Date. The report will list all the products for which entitlement’s start date is greater than or equal to the specified Start Date.  
- **Entitlement End Date**: It is the entitlement End Date. The report will list all the products for which entitlement’s end date is less than or equal to the specified End Date.  
- **Customer Name**: This field is used to generate report for a specific customer.  
- **Customer Ref ID**: This is the unique reference ID of the customer.  
- **Contact Email Id**: It is the e-mail ID of the contact for whom the entitlement was created.  
- **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.  
  - The All option refers to all entitlements statuses—Enabled, Disabled, and Revoked.  
- **Output Format**: The available options are HTML, PDF, Excel, and RTF. |
| Custom Vendor Attribute Report     | Provides information about entitlements that contain the specified vendor attribute, along with customer details. The report data is grouped | - **Vendor Attribute**: The vendor attribute for which you want to view the report. If a vendor attribute is not specified, all entitlements which contain vendor attribute are displayed.  
- **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled |
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Input Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>by vendor attribute.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The All option refers to all entitlement statuses—Enabled, Disabled, and Revoked.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Output Format:</strong> The available options are HTML, PDF, Excel, and RTF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Log Reports</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Audit Log Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lists all the operations performed in EMS during the specified duration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Start Date:</strong> Date starting from when you want to view the audit log.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>End Date:</strong> Date till when you want to view the audit log.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Output Format:</strong> The available options are HTML, PDF, Excel, and RTF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Activation (Deployment) Reports</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Most Popular Product Sold Report</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displays the products that are used by the highest number of customers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Entitlement Start Date:</strong> It is the entitlement Start Date. The report will list all the products for which entitlement’s start date is greater than or equal to the specified Start Date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Entitlement End Date:</strong> It is the entitlement End Date. The report will list all the products for which entitlement’s end date is less than or equal to the specified End Date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Output Format:</strong> The available options are HTML, PDF, Excel, and RTF.</td>
</tr>
</tbody>
</table>
### Deployment Expiration Report

Displays the list of entitlements for which the expiration date of associated license models falls within the number of days specified.

- **Days Before Expiration**: It is the number of days left to the feature expiry.
- **Group By**: You can view records grouped by week, month, quarter, or year.
- **Output Format**: The available options are HTML, PDF, Excel, and RTF.

If there is no limit on the expiration date of a license model, the end date is considered as a year greater than 2500.

### Usage Reports

#### User Usage Report

Displays the total usage time (in seconds) or the total usage count per feature for each user of a selected customer.

- **Customer Name**: This field is used to generate report for a specific customer.
- **Customer Ref ID**: The unique reference ID of the customer.
- **Start Date**: Date from when the usage data is required.
- **End Date**: Date up to when the usage data is required.
- **Usage Type**: Type of license model (count or time) for which you want to view the usage. By default, Count is selected.
- **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.

The **All** option refers to all entitlements statuses—Enabled, Disabled, and Revoked.

- **Output Format**: The available options are HTML, PDF, Excel, and RTF.

#### Feature Usage Report

Displays the total usage time (in seconds) or the total usage count per

- **Start Date**: Date from when the usage data is required.
- **End Date**: Date up to when the usage data is required.
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Input Parameters</th>
</tr>
</thead>
</table>
| Product Usage Report| Displays the total usage time in seconds or the total usage count per feature for each user of a selected customer grouped by product.                                                                                                                                         | ▪ **Usage Type:** Type of data aggregation that can be either Count or Time. The default is Count.  
▪ **License Model:** Type of license model for which the usage is required.  
▪ **Entitlement Status:** Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.  
   - The **All** option refers to all entitlements statuses—Enabled, Disabled, and Revoked.  
▪ **Output Format:** The available output types are HTML, PDF, Excel, and RTF.                                                                                                                                 |
| Grace Report        | Displays a list of customers whose licenses are running in grace state, along with the feature details. You can generate this report for all or a small subset of customers.                                                                                                               | ▪ **License Model:** Type of license model.  
▪ **Output Format:** The available output types are HTML, PDF, Excel, and RTF.                                                                                                                                 |


<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Input Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most Popular Prepaid Features Report</td>
<td>Lists the specified number of topmost consumed features having prepaid license model.</td>
<td><em>Customer Name</em>: Customer for whom the usage data is required.&lt;br&gt;<em>Customer Ref ID</em>: The unique reference ID of the customer.&lt;br&gt;<em>Start Date</em>: Date from when the usage data is required.&lt;br&gt;<em>End Date</em>: Date up to when the usage data is required.&lt;br&gt;<em>Number of Records</em>: Number of features you want to view report for.&lt;br&gt;<em>Output Format</em>: The available output types are HTML, PDF, Excel, and RTF.</td>
</tr>
<tr>
<td>Least Popular Prepaid Features Report</td>
<td>Lists the specified number of least consumed features having prepaid license model.</td>
<td><em>Customer Name</em>: Customer for whom the usage data is required.&lt;br&gt;<em>Customer Ref ID</em>: The unique reference ID of the customer.&lt;br&gt;<em>Start Date</em>: Date from when the usage data is required.&lt;br&gt;<em>End Date</em>: Date up to when the usage data is required.&lt;br&gt;<em>Number of Records</em>: Number of features for which you want to generate report.&lt;br&gt;<em>Output Format</em>: The available output types are HTML, PDF, Excel and RTF.</td>
</tr>
<tr>
<td>Remaining Executions Prepaid Report</td>
<td>Displays a list of customers for whom the allowed number of prepaid executions is about to exhaust. You can use this report to inform customers that their licenses are approaching expiration, and they need to renew the license timely to continue using the service.</td>
<td><em>Remaining Execution Criteria</em>: Specifies how to calculate the remaining executions. You can filter by either number or percentage of remaining executions.&lt;br&gt;<em>Value</em>: Enter a value for the specified criteria.&lt;br&gt;For example, on selecting <em>Percentage Remaining</em> in the <em>Remaining Execution Criteria</em> field and <em>10</em> in the <em>Value</em> field, the data is retrieved for customers whose only 10% prepaid executions have been left (90% executions have been used).&lt;br&gt;<em>Entitlement Status</em>: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default. The <em>All</em> option refers to all entitlement statuses—Enabled, Disabled, and Revoked.</td>
</tr>
<tr>
<td>Report Name</td>
<td>Description</td>
<td>Input Parameters</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Feature Usage Based on Vendor Attribute Report | Provides usage information about the features that contain the specified [vendor attribute](https://example.com). The usage of historical vendor attributes is also available in the report. It means that if a vendor attribute value is changed during entitlement reconfiguration, the report shows usage data for old and new vendor attributes.                                                                                           |  - **Output Format**: The available output types are HTML, PDF, Excel, and RTF.  
  - **Start Date**: Date from when the usage data is required.  
  - **End Date**: Date up to when the usage data is required.  
  - **Vendor Attribute**: The vendor attribute for which you want to view the report.  
  - **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.  
  - The **All** option refers to all entitlements statuses—Enabled, Disabled, and Revoked.  
  - **Output Format**: The available options are HTML, PDF, Excel, and RTF.                                                                                                                                                                                                                           |
| Peak Capacity Report                           | Provides maximum capacity of a postpaid feature during a given billing period across one or all entitlement(s) of a customer. In the report, the [Capacity Provisioned Data](https://example.com) section contains the Capacity Attribute specified for a postpaid feature in EMS. The [Peak Capacity Data](https://example.com) section contains the maximum peak capacity of each (or selected) feature(s) across all (or selected) entitlements, for given duration and granularity. |  - **Customer Name**: Name of the customer for whom you want to determine peak capacity.  
  - **Customer Ref ID**: The unique reference ID of the customer.  
  - **Entitlement ID**: ID of the entitlement for which you want to determine the peak capacity of a customer.  
  - **Feature Name**: The feature name for which you want to determine the peak capacity of a customer.  
  - **Feature ID**: The feature ID for which you want to determine the peak capacity of a customer.  
  - **Start Date**: Date from when the peak capacity data is required.  
  - **End Date**: Date up to when the peak capacity data is required.  
  - **Granularity (hrs)**: Granularity of time interval, in hours, at which peak capacity is to be reported. Its value can range from 1 to 744 hours. You can enter the desired value or select a predefined value from the drop-down list.  
  - **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.   |
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Input Parameters</th>
</tr>
</thead>
</table>
| Vendor Info Usage Report | Shows usage data grouped by the vendor information. For example, you can use this report to filter usage data based on a user's role, region, or department. This report is generated based on the vendor-specific information specified in Run-time during the login call, using the optional parameter 'VendorData'. See Run-time Guide for details. | - **Customer Name**: Customer for whom the usage data is required.  
- **Customer Ref ID**: Reference ID of the customer for whom the usage data is required.  
- **Start Date**: Date from when the usage data is required.  
- **End Date**: Date up to when the usage data is required.  
- **Feature Name**: The feature name for which you want to retrieve the usage data.  
- **Feature ID**: The feature ID for which you want to retrieve the usage data.  
- **Vendor Data**: Filters the report based on the value of the 'VendorData' attribute provided during the login API call. You can display report for only non-null and non-blank values of VendorData, or for all values including blanks.  
- **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.  
- The **All** option refers to all entitlements statuses—Enabled, Disabled, and Revoked.  
- **Output Format**: The available options are HTML, PDF, Excel, and RTF. |
| Raw Usage Data Report  | Retrieves raw usage data. This report provides information of customer, entitlement, products, features,  |
|                       |                                                        | - **Start Date**: Date from when the usage data is required. The startDate is appended with 00:00:00.  
- **End Date**: Date till when the usage data is required. The endDate is appended with 23:59:59.  
- **Customer Name**: Customer for whom the usage data is required.  
- **Output Format**: The available options are HTML, PDF, Excel, and RTF. |
users, usageType, vendor data, and client machine's host address.

The input start date is appended with 00:00:00 and end date is appended with 23:59:59. All usage records having partial or full usage between given report dates are considered.

- **Customer Ref ID**: Reference ID of the customer for whom the usage data is required.
- **Feature Name**: The feature name for which you want to obtain raw usage data of a customer.
- **Feature ID**: The feature ID for which you want to obtain raw usage data of a customer.
- **Entitlement ID**: ID of the entitlement for which you want to obtain raw usage data of a customer.
- **Product Name**: Product name-version in given entitlement of a customer to which usage raw data belongs.
- **Product Version**: Product version in the given entitlement of a customer to whom raw usage data belongs.
- **Entitlement Status**: Entitlement status for which you want to generate report. The available options are Enabled, Disabled, Revoked, Enabled and Disabled, and All. The default selection is Enabled and Disabled. The revoked entitlements are not included by default.

The **All** option refers to all entitlements statuses—Enabled, Disabled, and Revoked.

- **Output Format**: The available options are HTML, PDF, Excel, and RTF.

- The usage reports are based on consumption rather than on sales data.
- All usage reports display data only for the usage sessions that fall within the specified Start Date and End Date.
- All reports display dates in the Standard GMT time zone.
- To view reports in Internet Explorer 9, you need to clear the **Do not save encrypted pages to disk** check box:

  Tools > Internet Options > Advanced > Security > Do not save encrypted pages to disk

- Only English and Japanese fonts are supported in reports.
- The **Is Activated** column in the generated reports indicates that the entitlement has been deployed on Cloud Connect.
E-mail Notifications

Notifications are e-mail messages sent by EMS to inform or remind the customers and software vendors about important events related to entitlements and associated features. You can send notification e-mails to contacts associated to an entitlement and/or to a defined list of recipients.

Notifications can be useful in the following ways:

- Timely messages drive customer license renewal efficiencies. The early notifications, such as 20 days before expiration or at 10% remaining executions, keep a customer well-informed of licenses that are approaching end. This allows the customer to take a proactive decision about license renewal.

- Notifications provide a mechanism for software providers to collect information about customers whose licenses are in grace or whose usage has exceeded a specified percentage. The software providers can use notifications as actions to follow up with customers and encourage them for license renewal or upgrade.

- The software providers can leverage notifications for customer profiling. For example, if a feature usage by a customer exceeds 90%, the customer might be interested in buying another related feature. The software providers can identify such customers who can be pitched for selling new features.

- The software providers can keep track of the trial licenses that are about to expire or have already expired, and can attempt to convert a prospective customer to a real customer.

10.1. About the Notifications Page

To reach the Notifications page, click Notifications on the EMS main menu. The Notifications page contains two major sections:

- **Global Parameters**: Parameters and settings that are applicable across all rules in the notification system.

- **Notification Rules**: Parameters and settings that are applicable at individual rule level.
10.2. Notification Rules

You can configure EMS to send e-mail notifications by setting up rules. Each rule is a statement that sets a specific notification when certain conditions are met. The subject and content of the notification e-mail are determined by the rule definition.

Sentinel Cloud EMS provides a comprehensive set of rules for configuring notifications related to license state and license usage. The table below lists all the available notification rules:

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
<th>Use Case</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Early Notifications</strong>¹</td>
<td>Allows the customers to receive a reminder much ahead the license expiration or count exhaustion so that they have ample time to renew the license.</td>
<td></td>
</tr>
<tr>
<td>License Subscription Expires in N Days</td>
<td>Notifies when the license is about to expire in the specified number of days.</td>
<td>For example, you can send notifications 30-days before the license expires.</td>
</tr>
<tr>
<td>License Consumption</td>
<td>Notifies when the usage exceeds a specified percentage threshold.</td>
<td>For example, if a customer has purchased 100 counts, you can notify when 90% of counts get consumed (only 10 counts remaining).</td>
</tr>
<tr>
<td>License Not Used From N Days</td>
<td>Notifies after the specified number of days if a license is not used even once after the purchase or renewal.</td>
<td>For example, you can remind the customer to use the feature if not used after 15 days of purchase or renewal. If the customer uses the feature, it generates revenue and helps gather customer feedback. If the customer does not use the feature, you can identify the reason why the feature is not being used, and can advise the customer to buy another feature best suiting requirements. This helps the customers get more value for their money.</td>
</tr>
<tr>
<td><strong>License Termination Notifications</strong></td>
<td>Helps keep the customer well-informed of the license outage.</td>
<td></td>
</tr>
<tr>
<td>License Subscription Expired</td>
<td>Notifies after the end date of customer's license has reached.</td>
<td>This rule is triggered irrespective of the grace limit.</td>
</tr>
<tr>
<td>License Usage Exhausted</td>
<td>Notifies after the usage count of customer's prepaid license has</td>
<td></td>
</tr>
</tbody>
</table>

¹Notifications will be sent each time the rules in this category are triggered.
<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
<th>Use Case</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>exhausted.</td>
<td>This rule is triggered irrespective of the grace limit.</td>
</tr>
<tr>
<td><strong>Grace Notifications for Software Providers</strong></td>
<td>Sends notifications to software providers a little earlier than the license outage.</td>
<td></td>
</tr>
<tr>
<td>License In Grace</td>
<td>Notifies after the license has run out but is running in the grace state.</td>
<td>Software providers can configure this rule to receive notifications about expired/exhausted licenses running in grace state and can actively follow up with customers via phone calls or e-mails for license renewals.</td>
</tr>
<tr>
<td><strong>CAUTION</strong></td>
<td>Do not configure this rule for Customer Contacts, because the Grace state is not visible to customers.</td>
<td></td>
</tr>
<tr>
<td><strong>Capacity Notifications</strong></td>
<td>Notifies if peak capacity approaches or reaches a specified limit. The capacity notifications are available for only on-premise applications.</td>
<td></td>
</tr>
<tr>
<td>Capacity Peak Exceeded</td>
<td>Notifies when peak capacity for a feature exceeds the limit set in Capacity Attribute. The rule is triggered only for postpaid features, for which Capacity Attribute has been defined.</td>
<td>Software providers can configure this rule to receive notifications about features for which peak capacity exceeds a specified value in a given billing period.</td>
</tr>
<tr>
<td>Capacity Peak Approaching</td>
<td>Notifies when the peak capacity for a feature exceeds a specified percentage threshold. The rule is triggered only for postpaid features, for which Capacity Attribute has been defined.</td>
<td>Software providers can configure this rule to receive an early notification about post-paid features for which peak capacity is about to reach a specified value. Suppose the limit defined in Capacity Attribute is 200. The percentage threshold is set to 80%. If at any time, peak capacity becomes 160 (80% of 200 = 160), a notification e-mail is sent.</td>
</tr>
</tbody>
</table>

**Notes:**
- The notification rules run at 12:00 PM (GMT).
- The notifications are not sent for features that are in Not Active, Expired, or Exhausted state, for features that are excluded from a product while creating an entitlement, and for features that belong to a disabled product/entitlement. See Viewing License State for information about license states.
10.3. Setting Up Notifications

To send notification e-mails, you need to complete the following steps:

1. Configure the SMTP server that EMS will use for sending e-mail notifications. See Configuring SMTP Server Settings.

2. Specify parameters for the rules. This includes defining a recipient list for each notification rule. See Defining a Notification Rule.
   
   While defining notification recipients, plan wisely which rules you want to run for yourself and which ones for the customer. For example, the grace notifications are useful for you while the reminders about expiring licenses are useful for your customers.

3. Enable the notifications at the global level. This enables all the notification rules. See Enabling Notifications.

4. Decide on a set of rules that best suit your business requirements, keep only the required set of rules enabled, and disable the rest. To disable a specific rule, go to the rule page and click Disable Rule.

You can also customize the content and style of the notification e-mail as per your requirements. See Downloading Notification E-mail Templates for Customization.

10.4. Configuring SMTP Server Settings

All notifications in Cloud EMS are sent via e-mail, so you must configure EMS to connect to an outgoing e-mail exchange server (or the SMTP server) that can be used for sending notifications. To configure the SMTP server settings:

1. In the left pane of the Notifications page, expand Global Parameters.

2. Click SMTP Server Settings and specify the parameter values as described in the table below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>IP address or the domain name of the SMTP server</td>
</tr>
<tr>
<td>Port</td>
<td>Port of the SMTP server</td>
</tr>
<tr>
<td>User Name</td>
<td>Mail user name that is used for sending e-mails from an authenticated e-mail server</td>
</tr>
<tr>
<td>Password</td>
<td>Password corresponding to the mail user name</td>
</tr>
<tr>
<td>E-mail From</td>
<td>E-mail address from which notifications are sent</td>
</tr>
</tbody>
</table>

3. Click Submit.
10.5. Defining a Notification Rule

To define a notification rule:

1. On the Notifications page, expand Notification Rules and click a rule.
2. Specify the rule parameters.
3. Specify the recipients to whom the notification e-mails are sent. The options available are:
   - **Customer Contacts** - Select to send notification to all the contacts associated to an entitlement.
   - **E-mail Recipients** - Select to send notifications to a defined list of e-mail addresses. You can use this option to send notifications to the software provider or contract operator. To define the list of e-mail addresses:
     a. Click the Recipients button. The Recipients dialog box is displayed.
     b. In the E-mail field, type the e-mail address you want to add, and click Add. The specified e-mail address is added to the Associated Recipient list.

   To delete the associated e-mail address, select the corresponding check box under Associated Recipient list, and click Delete.

   **Warning**
   Add the e-mail recipients carefully because these recipients become applicable for a rule globally. They receive all the notifications for the specified rule irrespective of whether they are associated to the entitlement/entity or not.
   So, ensure not to add any Customer Contacts here.

   The notifications are also sent to the e-mail address of an ISV's representative, if any is associated with an entitlement by using EMS web services.

4. Click Enable to enable the rule. The Enable button is available only if the notification functionality is globally enabled.
5. Click Submit.

10.6. Enabling Notifications

To send notification e-mails, you must enable the notification functionality and ensure that the required rules are also enabled.

**Enabling the Notification Functionality**

By default, the notification functionality is disabled. To enable the notification functionality:
1. On the Notifications page, expand Global Parameters and click Global Status.
2. Click Enable.

Initially all the notification rules are disabled, so the first time you enable the global status, all the rules get enabled. Afterward, the previous state of individual rules is retained during global enabling.

Suppose you followed the following sequence:
(a) Enabled the global status for the first time (b) Set individual rule status to Enable or Disable (c) Disabled the Global Status (d) Enabled the Global Status

At step (d), only those rules will be enabled that were in Enabled state before the Global Disable i.e. step (c).

**Enabling a Specific Rule**

Once notifications are globally enabled, a toggle button Enable Rule/Disable Rule is displayed on every rule page. You can use the button for enabling or disabling a rule individually.

### 10.7. Downloading Notification E-mail Templates for Customization

The layout and content of the notification e-mails are defined using template files (.tpl). These templates files are customizable so you can change the format and content of the notification e-mails to suit your requirements. You can specify what information to include in the notification e-mail and how to style the information. For example, you can change the font size or font color of text elements, change a paragraph to a table, or include additional information such as logo, copyright text, or a personalized message.

You can configure the notification e-mail body but not the subject line.

There is one notification template available per rule.

The steps to customize notification e-mails are:

1. Download the notification e-mail templates from the EMS portal.
2. Customize the templates as per your requirements. You can edit the template file in any HTML editor.

Since notification templates are plain HTML files, you can change most of the elements in it. However, make sure that you do not change the entries that are surrounded by # (hash), for example, #productName#. These entries are placeholders for dynamic data. Following is a list of the placeholders available in the notifications files:

<table>
<thead>
<tr>
<th>Placeholders</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#customerName#</td>
<td>Customer Name</td>
</tr>
<tr>
<td>Placeholders</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>#eid#</td>
<td>Entitlement ID</td>
</tr>
<tr>
<td>#productName#</td>
<td>Product Name</td>
</tr>
<tr>
<td>#productVersion#</td>
<td>Product Version</td>
</tr>
<tr>
<td>#productRowStart#</td>
<td>Start Index of the Table row</td>
</tr>
<tr>
<td>#productRowEnd#</td>
<td>End Index of the Table row</td>
</tr>
<tr>
<td>#featureName#</td>
<td>Feature Name</td>
</tr>
<tr>
<td>#featureData#</td>
<td>Calculated value of rule parameter, such as Expire In(Days), and Unused From(Days)</td>
</tr>
</tbody>
</table>

3. E-mail the customized templates to SafeNet Support Executive, who will incorporate the modified templates in EMS.
Admin Console

Admin Console provides an easy-to-use interface for configuring and managing various properties of Sentinel Cloud server-side components: EMS and Cloud Connect.

Admin Console is available only to administrators.

To view Admin Console, login to the Sentinel EMS portal as the administrator and click Configure > Admin Console.

The settings that you can configure using Admin Console are divided into the following categories:

- Outgoing E-mail Server Settings
- Entitlement Certificate E-mail Settings
- General Settings
- On-premise Licensing Settings
- License Model Time to Live (TTL)
- Concurrency Cleanup and Abandoned Session Handling
- Technical Support Contacts

### 11.1. Outgoing E-mail Server Settings

The following settings are used to configure the outgoing e-mail exchange SMTP server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Host</td>
<td>IP address or the DNS name of the e-mail exchange server.</td>
</tr>
<tr>
<td>SMTP Port</td>
<td>SMTP port.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 25</td>
</tr>
<tr>
<td>User Name</td>
<td>User name of authenticated SMTP server.</td>
</tr>
<tr>
<td></td>
<td>*User name and password of SMTP server are required if authentication is</td>
</tr>
<tr>
<td></td>
<td>needed, otherwise they are optional.</td>
</tr>
<tr>
<td>Password</td>
<td>Password corresponding to the above user name.</td>
</tr>
</tbody>
</table>
## 11.2. Entitlement Certificate E-mail Settings

The following properties apply to entitlement certificate e-mails sent by Sentinel EMS:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-mail Required</td>
<td>Specifies whether or not to send entitlement certificate e-mails when an entitlement-related operation is performed (such as creating or reconfiguring an entitlement).</td>
</tr>
</tbody>
</table>
|                                 | - **No**: Sentinel EMS does not send entitlement certificate e-mails.  
                                    | - **Desired**: Sentinel EMS sends entitlement certificate e-mails.                                                                                           |
|                                 | In this case, you must specify values of the following fields: E-mail Recipient, E-mail From, SMTP Host, and SMTP Port.                                                                                       |
| **Default Value**: No           |                                                                                                                                                                                                           |
| E-mail Required from View       | Specifies whether or not to forward the entitlement certificate to the specified e-mail address when the Email button on the Entitlement Certificate screen is clicked.                                            |
| Certificate                     | - **No**: Sentinel EMS does not forward entitlement certificate e-mails.  
                                    | - **Desired**: Sentinel EMS forwards entitlement certificate e-mails.                                                                                       |
| **Default Value**: No           |                                                                                                                                                                                                           |
| E-mail Recipient                | Specifies to whom the e-mails are sent. Options available are:                                                                                                                                           |
|                                 | - **ISV**: The entitlement certificate e-mails are sent to the e-mail address specified in the ISV E-mail Address field.                                                                                      |
|                                 | - **Customer**: The entitlement certificate e-mails are sent to the contact e-mail address specified in the entitlement.                                                                                      |
|                                 | - **Both**: The entitlement certificate e-mails are sent to ISV and customer's contacts.                                                                                                                   |
|                                 | For values **ISV** and **Both**, e-mails are also sent to the e-mail address of an ISV’s representative, if any is associated with an entitlement by using EMS web services.                                       |
| ISV E-mail Address              | The entitlement certificate e-mail is sent from this e-mail address. This field is enabled when E-mail Required is set as Desired and E-mail Recipient is selected as either ISV or Both.                                    |
| E-mail From                     | The sender's e-mail address that appears in the entitlement certificate e-mails. This field is enabled when E-mail Required is set as Desired.                                                             |
| Cc                              | Send carbon copies of the entitlement certificate e-mails to this address. You can provide semicolon-separated values. You can enter up to 256 alphanumeric characters including special characters.               |
| Bcc                             | Send blind carbon copies of the entitlement certificate e-mails to this address. You                                                                                                                      |
### 11.3. General Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ent. Creation Subject</td>
<td>Subject of the entitlement certificate e-mails that are sent on entitlement creation. You can enter up to 256 alphanumeric characters including special characters.</td>
<td>EMS - Entitlement Certificate</td>
</tr>
<tr>
<td>Ent. Reconfiguration Subject</td>
<td>Subject of the entitlement certificate e-mails that are sent on entitlement reconfiguration. You can enter up to 256 alphanumeric characters including special characters.</td>
<td>EMS - Entitlement Successfully Reconfigured</td>
</tr>
<tr>
<td>Ent. Certificate View Subject</td>
<td>Subject of the entitlement certificate e-mails that are sent by using the Email button on the Entitlement Certificate screen. You can enter up to 256 alphanumeric characters including special characters.</td>
<td>EMS - License Certificate</td>
</tr>
</tbody>
</table>

#### 11.3. General Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard Refresh Hit Count</td>
<td>Number of hits at <a href="#">Home Page</a> after which its contents are refreshed.</td>
</tr>
<tr>
<td></td>
<td>Range: 1 to 100</td>
</tr>
<tr>
<td>Max Records Per Response (Web Services)</td>
<td>Maximum number of records that are returned by EMS Web service calls.</td>
</tr>
<tr>
<td></td>
<td>Range: 1 to 200</td>
</tr>
<tr>
<td>Default Customer RefID Type</td>
<td>Default value to be shown as selected in the Customer Ref ID Type drop-down list while creating a new customer (in the Create New Customer screen). The options available are: Manual, Auto Increment, and GUID.</td>
</tr>
</tbody>
</table>

#### 11.4. On-premise Licensing Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-premise Entitlement Level</td>
<td></td>
</tr>
<tr>
<td>Virtual Machine</td>
<td>Controls the default licensing behavior in virtualized environment. It is selected by default which means that a protected application is allowed to run on a virtual machine. You can configure this property only for on-premise entitlement level entitlements. For on-premise feature level, the setting is considered enabled always.</td>
</tr>
<tr>
<td>Clone Protection</td>
<td>Controls whether Clone Protection is enabled or disabled by default. When selected, clone protection is enabled indicating that a clone machine cannot</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>consume an existing license. Its value depends on Virtual Machine check box. It can be turned on or off only if Virtual Machine check box is selected. You can configure this property only for on-premise entitlement level entitlements. For on-premise feature level, the setting is considered enabled always.</td>
</tr>
<tr>
<td>Default Detach Interval (hrs)</td>
<td>Default number of hours to be shown in the <strong>Detach Interval</strong> field, which is available when you <strong>add products to a new entitlement</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 2160 hours</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1 to Max Detach Interval</td>
</tr>
<tr>
<td>Max Detach Interval (hrs)</td>
<td>Maximum value allowed for the <strong>Detach Interval</strong> field, which is available when you <strong>add products to a new entitlement</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 87600 hours</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1 to 175200 hours</td>
</tr>
<tr>
<td>State Sync Interval (mins)</td>
<td>License refresh time and usage sync time for connected mode of on-premise feature level licensing. Usage sync time for detached mode (feature level and entitlement level) of on-premise licensing.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 30 minutes</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 10 to 43200 minutes</td>
</tr>
</tbody>
</table>

**On-premise Feature Level**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Detach Interval (hrs)</td>
<td>Default number of hours to be shown in the <strong>Detach Interval</strong> field, which is available when you <strong>add products to a new entitlement</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 2160 hours</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1 to Max Detach Interval</td>
</tr>
<tr>
<td>Max Detach Interval (hrs)</td>
<td>Maximum value allowed for the <strong>Detach Interval</strong> field, which is available when you <strong>add products to a new entitlement</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 87600 hours</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1 to 175200 hours</td>
</tr>
<tr>
<td>Default Connected Store Interval (mins)</td>
<td>Default number of minutes to be shown in the <strong>Cache Interval</strong> field, which is available when you <strong>add products to a new entitlement</strong> (Feature Level caching mode).</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 60 minutes</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 60 to Max Connected Store Interval</td>
</tr>
<tr>
<td>Max Connected Store Interval (mins)</td>
<td>Maximum value allowed for the <strong>Cache Interval</strong> field, which is available when you <strong>add products to a new entitlement</strong> (Feature Level caching mode).</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 43200 minutes</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 60-43200 minutes</td>
</tr>
<tr>
<td>State Sync Interval (mins)</td>
<td>License refresh time and usage sync time for connected mode of on-premise feature level licensing. Usage sync time for detached mode (feature level and entitlement level) of on-</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 60-43200 minutes</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| premise licensing.  
**Default value:** 30 minutes  
**Range:** 10 to 43200 minutes |
| **Connected Store Refresh Threshold (%)** | The percentage of detach interval that should get elapsed before a new license slice can be generated on state sync. It is applicable only for connected store created for feature level caching mode.  
Say this value is 10 hours. On the next state sync, the new license slice will be generated only if 7 hours have elapsed.  
It is a read-only property.  
**Default value:** 70% |
| **General** | Select or clear this check box to allow or deny detaching a license for duration less than that of a currently active license. The licenses are detached by using the transfer call. |
| **Example** | Let us assume this check box is selected.  
Suppose a user detaches a license for 24 hours. Station count consumed is 1.  
After 2 hours, the same user requests second license for 12 hours. The license is granted (as the check box is selected). There is no change in station count since the license has been requested from same identity and same machine.  
After 12 hours, the second license expires freeing up the station count and thus enabling the user to detach another license. However, the first license (of 24 hours duration) is still running on the current machine. In this case, even though a license is active on the user’s machine still an additional license becomes available on the server.  
This example shows the possible license misuse when license detach is allowed for duration less than the duration of the currently active license.  
It is ISV’s decision whether or not to permit such scenario. |
| **Default Value:** |  
- This check box is clear by default, and we do not recommend selecting it as it may allow misuse of license by the end user.  
- For existing ISVs who are using an old Run-time version (3.5 or below) or old Cloud Connect web services version (below 1.2), this check box is selected by default. This is to ensure that existing applications continue to behave as before. Changing the setting may result in an error (-20000 by Run-time and 1044 by Cloud Connect web services). |
11.5. License Model Time to Live (TTL)

Time to Live (TTL) specifies the duration for which Run-time caches licenses in memory for features of non-global concurrent license models, such as Postpaid and Subscription. For more details, see Sentinel Cloud Run-time Guide, section "Caching (Cloud Deployment)".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Postpaid TTL (secs)</td>
<td>TTL for a postpaid feature.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 1800 seconds</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1800 to 2592000 seconds</td>
</tr>
<tr>
<td>Subscription TTL (secs)</td>
<td>TTL for a subscription feature.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 1800 seconds</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1800 to 2592000 seconds</td>
</tr>
</tbody>
</table>

TTL is applicable only for Cloud deployment type.

11.6. Concurrency Cleanup and Abandoned Session Handling

The following configurations are used to manage concurrency and abandoned sessions.

For more details on how abandoned sessions are managed, see Sentinel Cloud Run-time Guide, section "Handling of Abandoned Sessions".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-premise Entitlement Level</td>
<td></td>
</tr>
<tr>
<td>Minimum Usage Count</td>
<td>Used to set usage count while completing a usage log record corresponding to an abandoned session. For example if this value is 10, the abandoned session will be completed with 10 usage count for count based license models.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 1</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 1 to 2147483647</td>
</tr>
<tr>
<td>Minimum Session Time (mins)</td>
<td>Used for completing a usage log record corresponding to an abandoned session. For the license models where the last refresh time is not derived, the abandoned sessions are completed by adding value of this property in start time.</td>
</tr>
<tr>
<td></td>
<td><strong>Default value:</strong> 30 minutes</td>
</tr>
<tr>
<td></td>
<td><strong>Range:</strong> 30 to 43200 minutes</td>
</tr>
<tr>
<td>Session Timeout (mins)</td>
<td>Helps in identifying the abandoned sessions. For example, if this value is 90 minutes, then whenever background process will run, it will check for records where stop time is null and last start time is less than</td>
</tr>
<tr>
<td></td>
<td>90 minutes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| (current time – 90) minutes. These sessions will be treated as abandoned sessions. Sessions will be completed by putting stop time = start time + Minimum Session Time. | **Default value:** 1440 minutes  
**Range:** 30 to 41760 minutes |
| On-premise Feature Level |  
| Minimum Usage Count | Used to set usage count while completing a usage log record corresponding to an abandoned session. For example if value is 10, the abandoned session will be completed with 10 usage count for count based license models.  
**Default value:** 1  
**Range:** 1 to 2147483647 |
| Minimum Session Time (mins) | Used for completing a usage log record corresponding to an abandoned session. For the license models where the last refresh time is not derived, the abandoned sessions are completed by adding value of this property in start time.  
**Default value:** 30 minutes  
**Range:** 30 to 43200 minutes |
| Session Timeout (mins) | This property helps in identifying the abandoned sessions. For example, if this value is 90 minutes, then whenever background process will run, it will check for records where stop time is null and last start time is less than (current time – 90) minutes. These sessions will be treated as abandoned sessions. Sessions will be completed by putting stop time = start time + Minimum Session Time.  
**Default value:** 1440 minutes  
**Range:** 30 to 41760 minutes |
| Cloud |  
| Session Timeout with Refresh (mins) | Helps in identifying the abandoned sessions for which the refreshSession API is not being called.  
Say this value is 90 minutes. If stop time is null and the last refresh time is less than (current time – 90) minutes, the session is treated as abandoned. Concurrency will be restored and sessions will be completed by putting last refresh time into stop time.  
**Default value:** 1440 minutes  
**Range:** 30 to 41760 minutes |
| Session Timeout without Refresh (mins) | Helps in identifying the abandoned sessions for which the refreshSession API is not being called.  
For example, say this value is 1440 minutes. If stop time is null and start time is less than (current time - 1440) minutes, the session is treated as abandoned.  
**Default value:** 1440 minutes  
**Range:** 30 to 41760 minutes |
| Minimum Usage Count | Used to set usage count while completing a usage log record corresponding to an abandoned session. For example if value is 10, the abandoned session will be }
130  Chapter 11: Admin Console

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>completed with 10 usage count for count based license models. Default value: 1 Range: 1 to 2147483647</td>
<td></td>
</tr>
<tr>
<td>Minimum Session Time (mins)</td>
<td>Used while completing a usage log record corresponding to an abandoned session. It determines the stop time for a session. This property is applicable for all license models except subscription concurrent license models. For the license models where the last refresh time is not derived, the abandoned sessions are completed by adding value of this property in start time. Default value: 30 minutes Range: 30 to 43200 minutes</td>
</tr>
</tbody>
</table>

11.7. Technical Support Contacts

The following properties apply to the entitlement certificate e-mails sent by Sentinel EMS. This information is appended at the end of the e-mail body.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Team Name</td>
<td>Support team name sent in entitlement certificate e-mails. You can enter up to 256 alphanumeric characters.</td>
</tr>
<tr>
<td>Phone</td>
<td>Support contact number sent in entitlement certificate e-mails.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Support e-mail ID sent in entitlement certificate e-mails. You can enter up to 256 alphanumeric characters.</td>
</tr>
<tr>
<td>E-mail Master Footer</td>
<td>Footer in entitlement certificate e-mails, for example, copyright information.</td>
</tr>
</tbody>
</table>

11.8. Action Buttons

The following action buttons are available at the bottom of the page:

- **Save**: To save the data entered.
- **Reset**: To reload the last-saved settings.
The Customer Portal

EMS provides you with the facility to maintain a customer portal so that the administrator at the customer end can view information related to entitlement, product usage, and billing.

The EMS customer portal is intended to help administrator at the customer side to view information related to entitlement, product usage, and billing.

12.1. Logging-in to the Customer Portal

The customer can access the portal by using the following steps:

1. Enter the URL http://<Hostname>:8080/ems/login.html, where <Hostname> stands for the host name/IP address/domain name of the EMS server. The login screen appears.

2. Click Customer Login, on the top-right corner of the login screen. The Customer Login screen appears. The customer can login to the Customer portal in the following ways:
   - Using Entitlement ID
   - Using User ID and Password

Logging-in by Entitlement ID

When an entitlement is generated, the customer receives an Entitlement ID (EID). He can log-in to EMS using this EID, and perform the following operations:

- View the details of the entitlement, the EID of which has been used for login.
- View the list of products (and features) associated with the entitlement.
- View the license state of features
- View usage data
- View billing data
- View concurrent sessions of a feature having concurrent license model associated to it.
- View Current Usage Count of a feature having prepaid license model associated to it.
- View service agreement attributes
- Add/delete user IDs, if the customer is an enterprise named user
- Manage secondary contacts, if the logged-in contact has been designated as primary.
Logging-in by User ID and Password

If the customer logs in using his user ID (e-mail address) and password, he can perform the following operation in the portal for all the entitlements created for him:

- View entitlement details for all the entitlements created for the user
- View the list of products and features associated in each of the entitlement
- Change password
- View the license state of features
- View license certificate
- View usage data
- View billing data
- View concurrent sessions of a feature having concurrent license model associated to it.
- View Current Usage Count of a feature having prepaid license model associated to it.
- View service agreement attributes
- Add/delete user IDs, if the customer is an enterprise named user.
- Manage secondary contacts, if the logged-in contact has been designated as primary.

Changing Password

To change the password, the customer needs to click the Change Password link at the top-right corner of the page. The page that follows prompts the customer to enter his old and new password.

12.2. Viewing Entitlement Details

If the customer logs on to EMS using his user ID and password, then all the entitlements for the customer are displayed. To view the details of an entitlement, select an entitlement in the left pane. The right side of page displays the entitlement details.

If the customer logs-in using his EID, then details of only one entitlement corresponding to the EID is displayed in the list.

12.3. Managing User IDs

In case of enterprise named entitlements, user IDs need to be mapped to the entitlement. This section describes how to add/delete user IDs to/from an enterprise named entitlement.
12.3.1. Adding User IDs to Enterprise Named Entitlements

To add user ID to a named entitlement:

1. If you have logged in using User ID and password, you need to first select the required entitlement in the left pane. (You can search the enterprise named entitlement for which you want to add user IDs.)

2. In the Entitlement Details pane, click . The Manage User IDs dialog box is displayed.

3. In the UserID text box, type the User ID and click Add. Repeat this step to add multiple User IDs.

4. Click Save.

12.3.2. Deleting User IDs from the Enterprise Named Entitlements

To delete a user ID from a named entitlement:

1. If you have logged in using User ID and password, you need to first select the required entitlement in the left pane. (You can search the enterprise named entitlement from which you want to delete user IDs.)

2. In the Entitlement Details pane, click . The Manage User IDs dialog box is displayed.

3. Select the check box(es) corresponding to User ID(s) you want to delete. Click Delete.

12.4. Viewing Usage Data

To view the details of products consumed, follow the steps given below:

1. If you have logged in using User ID and password, perform the following steps to view product details:
   a. In the left pane, select the entitlement to which the product belongs.
   b. On the right side, expand Associated Product and Features, to view a list of products.

2. Select the product for which you want to view billing data. Details of the selected product are displayed in the Product Details pane.

3. Click the View Usage Data icon, . The View Usage Data dialog box is displayed.

4. Select dates in the From and To fields to specify the duration for which you want to view the usage data.

5. Click Submit.
Details, such as feature name, start/end dates, usage count, and usage time are displayed for the selected product.

12.5. Viewing Billing Data

You can also view the billing data for all the products included in an entitlement. Different type of billing details that you can view are:

- **Itemized Billing**: A descriptive bill that provides consumption details for a product on per feature per customer basis.
- **Detailed Billing**: It is less descriptive than the itemized bill and provides consumption details per feature.
- **Brief Billing**: It provides a brief summary of the products consumed within a specified period.

The steps to view billing data are:

1. If you have logged in using User ID and password, perform the following steps to view product details:
   a. On the main menu, click **Entitlements**.
   b. In the left pane, select the entitlement to which the product belongs.
   c. On the right side, expand **Associated Product and Features**, to view a list of products.
2. Select the product for which you want to view billing data. Details of the selected product are displayed in the **Product Details** pane.
3. Click the Billing Data icon, ![Billing Data icon]. The **Billing Data** dialog box is displayed.
4. Select dates in the **From** and **To** fields to specify the duration for which you want to view the billing data.
5. From the drop-down list, select the type of bill you want to view.
6. Click **View**. Billing details are generated in the excel format.

To view reports in Internet Explorer 9, you need to clear the **Do not save encrypted pages to disk** check box:

**Tools** > **Internet Options** > **Advanced** > **Security** > **Do not save encrypted pages to disk**

12.6. Retrieving License State

Please see section, **Viewing License State**

12.7. Viewing Concurrent Session

Please see section, **Viewing Concurrent Session**
12.8. Viewing Usage Count

Please see section, Viewing Usage Count Viewing License State

12.9. Managing Secondary Contacts

A contact is an individual who is the single point of contact for an entitlement. All the e-mails related to an entitlement are sent to the e-mail address specified for the contact.

One of the contacts can be designated as the primary contact for a customer. Other contacts are created as secondary by default. The primary contact can add, associate, remove, edit, or delete secondary contacts after logging-in to EMS.

A logged in primary contact can perform the following contact management functions:

- Creating a New Secondary Contact
- Editing Secondary Contacts
- Deleting Secondary Contacts
- Associating Secondary Contacts to an Entitlement
- Removing Secondary Contacts from an Entitlement

12.9.1. Creating a New Secondary Contact

To create new secondary contacts for a customer:

1. On the Entitlements page, click Create Contact under the Contact Association group.
2. Enter the e-mail address of the contact in the Contact E-Mail field.
3. Enter the telephone number of the customer in the Contact No. field.
4. Enter a name for the contact in the Contact Name field.
5. Enter values for RefID 1 and RefID 2 if required.
6. Select the Login Allowed check box to allow the contact to login to EMS. The system will prompt you to create a password for this contact.

```plaintext
Login Allowed: ✓

* Password: [enter password]  * Confirm Password: [confirm password]
```

7. Enter the password in the Password and Confirm Password fields.
8. Leave the Is Primary check box unselected.
9. Enter the Billing Details\(^1\) and Shipping Details\(^2\).

10. Click Submit.

### 12.9.2. Editing Secondary Contacts

To edit details of an associated contact, click the name of the contact, and click Edit in the pop-up that appears. For field-related details, see Creating a New Secondary Contact.

### 12.9.3. Deleting Secondary Contacts

To delete an associated contact, click the name of the contact, and click Delete in the pop-up that appears.

The initial contact associated while creating an entitlement can not be deleted.

### 12.9.4. Associating Secondary Contacts to an Entitlement

Click Associate Contact under the Contact Association group on the Entitlements page. In the Contact Association pop-up, select the contact(s) and click Submit.

### 12.9.5. Removing Secondary Contacts from an Entitlement

Select the check box for the contact you want to remove under the Contact Association group on the Entitlements page, and click Remove Contact.

---

\(^1\)Refers to the address registered on your credit card. In simple words, it is the address where you receive the statements for your credit card. For your order to be approved when shopping online, the billing address provided by you has to match this address.

\(^2\)Refers to the address where you want to receive your orders. It could be your home or office.
About Capacity

*Capacity*, an integer value passed in a login session, is an indicator of load during the session. The load can have different meanings in different environments. It could be number of subscribers consuming the application at a given time or the number of cores on which an application is running. A capacity value is associated with a login session, and remains valid only for that session. A logout call for the session releases the capacity.

Capacity is not automatically determined by Run-time. Its value is provided by an application based on the factors that it understands, such as number of cores or number of subscribers. Run-time only records these values for the purpose of computing peaks for the specified interval.

Capacity values submitted by application instances are used to compute a cumulative value, called *Peak Capacity*, which determines the peak load achieved during a given period. *Peak Capacity* is defined as the cumulative load across a number of simultaneous sessions that are in use by a customer, in a given duration. Since multiple instances of an application might be running for a customer, the *Peak Capacity* is the cumulative capacity across multiple instances for the same customer that is considered for calculating the load.

Suppose you are using capacity to represent the number of times a feature is consumed. You can later determine peak loads on a feature for different time intervals during a given billing period. Based on peak capacity values, you can bill your customers. The time intervals at which peak load is calculated is termed as *granularity*.

The Capacity feature is available only for on-premise applications, for features with postpaid license model.

Specifying Capacity

To implement the capacity-based usage tracking, capacity needs to be specified with the Run-time login call (as an optional parameter). It is then associated with a login session and used by Cloud Connect for computing the peak capacity.

- A capacity value remains valid for a login session. With a logout call, the capacity gets free.

Computing Peak Capacity

You can compute peak capacity by using any of the following:

- The Peak Capacity Report
- The *retrievePeakCapacity* Web service of EMS

Both of them use capacity records to compute the peak capacity. They determine the peak capacity of one/all postpaid feature(s) in a given duration across all entitlements of a customer.
Few notes on the `retrievePeakCapacity` web service:
- It provides raw usage data, which you need to process further for billing purposes.
- It calculates peak capacity based on the data available in Cloud Connect at a particular point of time.
- It provides information of only the postpaid features.

For details, refer to *EMS Web Services Guide*.

**Defining Capacity Attribute**

If you want to set a limit on the peak capacity so that you get notified when your customers approach or cross the limit, you can use EMS to set *Capacity Attribute*. Capacity Attribute is the maximum limit that the peak capacity of a feature can attain across all login sessions at any given point of time. You can specify Capacity Attribute in the postpaid license model associated to a feature by using EMS.

Capacity Attribute can be used as the limit beyond which you may want to monitor the feature usage. Capacity Attribute is used to enable processing of capacity values recorded by an application for postpaid features. Based on Capacity Attribute, you can configure notifications and implement application logic (explained in further sections).

**Configuring Capacity-based E-mail Notifications**

You can configure e-mail notifications in EMS that are sent when the peak capacity of a feature approaches or reaches the limit set in Capacity Attribute. The related notification rules available in EMS are: *Capacity Peak Exceeded and Capacity Peak Approaching*.

**Implementing Capacity-based Decision Making**

You can use the `getInfo` Run-time API to query the capacity information and define application logic based on it. For example, you can configure your application to show warning messages to user on exceeding peak capacity limit.

The `getInfo` API returns Capacity Attribute and peak capacity of given feature(s) in the last N hours. For details, see section *Retrieving Peak Capacity Information* of the Run-time Guide.

**Example**

This example explains how capacity information is processed and used.

**Sample Data** (Collected by Run-time)

To charge customers based on the capacity, a vendor needs to determine how much peak capacity is consumed in a billing period. Suppose, the customers used the application and recorded capacity for a particular feature, across a group of entitlements, in a day. The following table shows the sample capacity values recorded at the time of login and logout.

<table>
<thead>
<tr>
<th>Time Instance</th>
<th>Capacity Requested (With login)</th>
<th>Capacity Returned (At logout)</th>
</tr>
</thead>
<tbody>
<tr>
<td>07:15</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>07:52</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>07:59</td>
<td></td>
<td>200</td>
</tr>
<tr>
<td>09:05</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>Time Instance</td>
<td>Capacity Requested (With login)</td>
<td>Capacity Returned (At logout)</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>10:17</td>
<td></td>
<td>400</td>
</tr>
<tr>
<td>12:30</td>
<td>700</td>
<td></td>
</tr>
<tr>
<td>13:45</td>
<td></td>
<td>500</td>
</tr>
</tbody>
</table>

The Run-time sends the above data from application to Cloud Connect.

**Computing Peak Capacity**

For the above data set, a vendor can determine the peak value of the capacity for a given billing period. In this case, it is 1 day or 24 hours. The report data can be refined by specifying *granularity* as input. *Granularity* specifies the *time interval*, in hours, at which peak capacity is reported. The entire duration is divided in time slices equal to granularity.

Assuming a granularity of 1 hour, the peaks for each time slice are computed, as listed below:

<table>
<thead>
<tr>
<th>Time Slice (granularity is 1 hour)</th>
<th>Peak Capacity</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>6:00 – 7:00</td>
<td>0</td>
<td>Indicates no capacity specified.</td>
</tr>
<tr>
<td>7:00 – 8:00</td>
<td>600</td>
<td>This equals 400 + 200. The logout at 07:59 is not considered. To calculate maximum capacity utilized during a time interval, the logout calls are ignored.</td>
</tr>
<tr>
<td>8:00 – 9:00</td>
<td>400</td>
<td>No capacity recorded between 8-9. So the peak capacity during this interval is actual capacity until 09:00, that is (400 + 200 – 200).</td>
</tr>
<tr>
<td>9:00 – 10:00</td>
<td>900</td>
<td></td>
</tr>
<tr>
<td>10:00 – 11:00</td>
<td>900</td>
<td></td>
</tr>
<tr>
<td>11:00 – 12:00</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>12:00 – 13:00</td>
<td>1200</td>
<td></td>
</tr>
<tr>
<td>13:00 – 14:00</td>
<td>1200</td>
<td></td>
</tr>
<tr>
<td>14:00 – 15:00</td>
<td>700</td>
<td></td>
</tr>
<tr>
<td>15:00 – 16:00 till 23:00 - 24:00</td>
<td>700</td>
<td>For session created at 12:30, the subsequent logout has not arrived. It means that the amount of capacity blocked has not been released completely. The residual capacity is carried on till the logout happens, that is till capacity becomes zero. So, the peak capacity remains same for all these intervals.</td>
</tr>
</tbody>
</table>

The graphical representation of this data by a vendor can be:
The above data is for all features across all entitlements, but this can be refined down to a single entitlement or to a single feature, as required.

**Defining Capacity Attribute and Configuring Notifications**

If vendors want to set a limit on the peak capacity so that they could be notified when their customers approach or reach the limit, they could use EMS to set *Capacity Attribute*.

Say, for the above example, Capacity Attribute is 1500.

- **EMS Notifications**

  Suppose the vendor configured the Capacity Peak Approaching notification rule, and set its percentage threshold to 80%. If at any time, peak capacity becomes 1200 (80% of 1500 = 1200), a notification e-mail is sent.

  Similarly for the Capacity Peak Exceeded notification rule, if at any time peak capacity becomes 1500, a notification e-mail is sent.

- **getInfo Notifications**

  The vendors can also query the above data by using the *getInfo* API. They need to specify capacity interval in the optional parameter specifying the last N hours for which capacity information is required. Let us say, the capacity interval is 15 hours. The getInfo API will retrieve highest peak capacities for the last 15 hours from the aggregated data available in Cloud Connect.

  In the above example, getInfo will return the following: Peak Capacity =1200 and Capacity Attribute = 1500.
Glossary

A

Administrator
Administrator is the primary user in EMS and manages namespaces, users, and roles. The administrator can also grant administrative rights to any user.

Authorization Map
The set of authorized features per user.

B

Billing Details
Refers to the address registered on your credit card. In simple words, it is the address where you receive the statements for your credit card. For your order to be approved when shopping online, the billing address provided by you has to match this address.

C

Cache Interval
Maximum duration (in minutes) for which a licenses can be cached locally in the case of on-premise feature level caching mode.

Capacity
Indicator of load on a feature during a login session. The load can have different meanings in different environments. It could be number of users consuming the application at a given time or the number of cores.

Capacity Attribute
A license attribute that is used to enable processing of capacity values recorded by an application for postpaid features. You must set Capacity Attribute in EMS if you want to be notified when your customers approach or reach a specified limit.

Contact
The individual who is the single point of contact for an entitlement. This contact may be pre-existing, and be associated at time of entitlement creation; or a new contact
may be created along with the entitlement. A contact may or may not belong to a customer.

**Customer**
Represented the organization/end user that owns an entitlement or needs license to run the protected application(s).

**Customer Reference ID**
The unique identification code of the customer. It is same in both EMS and ISV application.

**Data Aggregation**
Process of converting raw usage data into processed data that can be used for billing and metering.

**Deployment Type**
Specifies if the entitlement is created to license the applications deployed on-premise or on cloud.

**Detach Interval**
Maximum number of hours for which a license can be detached for use in offline mode.

**End user**
The end user is the customer for ISV who can be an individual user or corporate user of the product an ISV is selling in the market.

**Entitlement**
It is the right granted by law or contract to use a particular software (or a group of software packages) within its set limits.

**Feature**
A feature is a functionality of any product an ISV wants to sell.
**Feature Catalog**
A collection of features, which has properties for the application or module to identify the features that are supposed to be licensed.

**Feature ID**
A unique digit assigned to every feature. It is used by a product (or, an ISV application) to enforce authorization at the feature level.

**Feature Name**
A unique user-friendly name of the feature specifying its functionality or other useful information.

**Isolated Machine**
An on-premise machine that is never connected to the Internet.

**License**
A file or string generated by a vendor from a package that describes under what conditions the vendor's software can run. Licenses are delivered to an end user's client machine or installed on a license server.

**License model**
A logical collection of attributes that define a template for selling a feature of a product in a particular manner.

**Named Entitlement**
Allows product usage to a specific retail user or assigned users in an enterprise.

**Namespace**
A container for products and features in EMS.

**On-premise**
A deployment type where the protected application is hosted within the premises of an enterprise customer.
Peak Capacity
The cumulative value of capacity. It indicates the cumulative load across a number of simultaneous sessions that are in use by a customer.

Product
The entity which an ISV wants to sell to an end user. A product may have multiple features in it.

Regular Expression
A regular expression can be specified for an attribute in a template to define some restrictions for the value of the attribute. Example of a Regular expression is \[-a-zA-Z0-9\]+(\.[a-zA-Z0-9]+)*

Report
A report is an organized presentation of data. It serves as the front-end to the information stored in a database. EMS supports generation of customer entitlement reports, audit log reports, and most popular product sold reports.

Role
Role acts as a container for a set of permissions like view, edit, add and delete on different activities a user can perform. A role can be associated with a user.

Service Agreement
A mutual agreement between a service provider and a customer. This agreement defines various attributes of products being offered, such as level of quality, performance, availability, etc.

Shipping Details
Refers to the address where you want to receive your orders. It could be your home or office.

Station Count
It specifies the maximum number of on-premise machines to which an entitlement can be served. You need to specify Station Count for on-premise entitlements that are created for entitlement level caching mode.
**Unnamed Entitlement**

Allows product usage to any user in the enterprise group.

**Vendor Attribute**

An attribute in license model that can be optionally set by the vendor at the time of license creation. The vendor can query its value in the protected application to define application logic.
A
add
  contacts 60
customer 57
  feature 44
  product 47
role 12
user 14
admin console 123
associate customer with entitlement 76
associate features with product 48
associate permissions with role 13
associate roles with user 15
  attribute groups 26
Authorization Maps 33

B
billing data 93

C
Cache Interval 81, 126
capacity 137
  attribute (limit) 30, 138
define 30, 137
notification 117
notifications 138, 140
  peak 30, 137
catalog 25
catalog permissions 23
change password 5
close protection 81, 125
concurrency 32
  concurrent limit 28
contact us ix
contacts 63
copy
  license model 35
data agreement
  frequency 38
delete
  contact 64
customer details 60
  entitlement 89
feature 51
namespace 24
product 53
role 17
user 18
deployment
  cloud 66
  on-premise client 66
  on-premise server 66
deployment type 66
Detach Interval 80, 126
E
edit
  contact details 63
customer details 59
feature details 51
namespace 24
product details 52
role details 16
user details 17
date 27
enforcement technology 26
Enterprise 67
enterprise named entitlement 67
enterprise unnamed entitlement 67
entitlement 65, 67
end date 27

F
feature caching mode 66
tenentile level 66
feature level 66
feature ID 42
feature name 42
features 50
forgot password? 5
forgot password? 5

G
global permissions 13
globally concurrent license 33
glance 28, 31, 97
grace limit 28

to 28

I
instance counting 28
isolated 66
isolated 66

L
license attribute 26-27
groups 26
license models 26
license state 97
lifecycle
  entitlement 67
  product 43

list
customers 59
entitlements 88
features 50
license models 34
namespaces 23
products 52
role 16
service agreements 39
users 17

M
maxum usage limit 28
measurement unit 28

N
named entitlement 67
namespace 21
notification 115
  enable 119
  rules 116
  setting up 118
  SMTP configuration 118
template 120
notification e-mail server 118
notification template
customize 120
download 120
notification status 120

P
peak capacity 30, 137
  notifications 140
  retrievePeakCapacity 137
perpetual license 37
post-paid 32
pre-paid 32
primary 56
products 52

R
Reconfigure 85
report
  audit log report 107
customer entitlement report 106
customer vendor attribute report 106-107
deployment expiration report 108
feature usage 108
feature usage based on vendor attribute report 111
grace count 109
least popular prepaid features 110
most popular prepaid features 110
most popular product sold 107
product usage 109
raw usage data 112
remaining executions prepaid 110
user usage 108
vendor info usage report 112
rule 116
Capacity Peak Approaching 117
Capacity Peak Exceeded 117
defining 119
License Consumption 116
License Enters in Grace 117
License Not Used From xx Days 116
License Subscription Expired 116
License Subscription Expires in xx Days 116
License Usage Exhausted 116
rule status 120

S

search
contact 63
customer 59
entitlement 88
namespace 24
role 16
user 17
secondary 57
service agreement 38
SFNTSupport 18
show all
contacts 63
customers 59
entitlements 88
features 50
namespaces 23
products 52
roles 16